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Introduction 

Warrior software Release 7.0 is a second-generation 32-bit program, while Release 8.0 is a Unicode 32-bit and 62-bit 
release. The Warrior software is a mature logging environment that stresses ease of use, wide versatility, with a true 
multitasking environment. This software can also be used from a desktop to replay, recalculate and print logs from the 
raw data or imported data from other systems such as LAS or LIS data. The Warrior software runs on Windows 
Operating Systems (Windows 2000, Windows XP, Windows 7 32-bit and Windows 7 64-bit. Operators need to be 
familiar with Windows and logging.  
 
The Warrior Tool Interface and Power Supply Panel is a new generation logging system. This system utilizes the USB 
Bus (Universal Serial Bus) along with DSP (Digital Signal Processor) technology providing the latest signal recovery 
technology available. This allows the PC to be upgraded independently as newer and faster PC's become available. 
Systems can be configured based on the services required at each site. The operator interface remains the same for 
each configuration, allowing the same look and feel for the operators. 
 
The Warrior Well Logging System consists of a Tool Interface and Power Supply Panel, a computer, a printer and 
optional depth, line speed, line weight panel, and perforating power supply. The tool interface panel contains the 
necessary circuits to interface to most cased hole tools, both analog and digital. The depth encoder and line weight 
interfaces are built into the panel, as is the down hole tool power supply. All functions are digitally controlled from the 
software, with the power supply having a manual control mode. The panel incorporates data acquisition functions 
primary DSP based, that interface to the host computer through the industry standard Universal Serial Bus (USB). A 
nine port USB hub is also incorporated inside the panel allowing a single cable connection to the host computer. A 
second monitor may usually be attached to provide a Hoist-man’s or client's display.  
 
The system supports most thermal well log plotters and a selection of color printers. An optional depth, line speed and 
line weight panel is available. This panel provides 12 Vdc. powered, independent depth measurement. It connects to 
the host computer through the USB and can be synchronized from the host depth or the host depth may be read from 
the depth panel. The Warrior logging system currently consists of the following components: 
 
CPU – Laptop/Desktop 
Monitor  
Shooting Panel 
Tool Interface and Power Supply (CP/PA/OP/SLAB) 
Keyboard 
Plotter 
Depth, Line Speed and Line Tension Panel (optional) 
UPS (optional) 
 
It is strongly suggested that the CPU and monitor (and optionally, the interface panel) be run from an UPS with a 
capacity of approximately 1000 VA. Do not attempt to use an on-line type UPS with diesel generators unless the 
manufacturer specifically states that the product is suitable for this application. The (cheaper) switching type UPS seem 
to work well. Loss of data is guarded against by periodic update of the data base files, however, the use of a UPS 
allows the system to be shut down in an orderly manner and may also condition the line power to the system, thus 
eliminating problems due to a noisy power source. 
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Installation and Safety 
 
Your safety and the safety of others is very important. 
 
We have provided important safety messages on the safe handling and installation of 
the Standard Cased Hole Panel or “STIP” in this manual. Always read and obey all 
safety messages. 
 

 

 

 
 
 
All safety messages will tell you what the potential hazard is, tell you how to reduce the 
injury, and tell you what you can happen if the instructions are not followed. 

 
 
 

 
 
 
 

 
 
 

This is the safety alert symbol 
This symbol alerts you to potential hazards that can kill or hurt you and others. 
All safety messages will follow the safety alert symbol and either the word DANGER or WARNING. 

DANGER 

WARNING 

You can be killed or seriously injured if you don’t immediately follow 
instructions. 
 
You can be killed or seriously injured if you don’t follow instructions. 

Important Safety Instructions 
WARNING: To reduce the risk of fire, electric shock, or injury when using your interface panel, follows these 
precautions 
 
: Plug into a grounded 3 prong outlet.  : Use nonflammable, plastic safe cleaner 
: Do not remove ground prong.   : Keep flammable materials and vapors away. 
: Do not use an extension cord.   : Disconnect power before installing panel 
: Disconnect power before servicing. 
: Disconnect   power before making any rear panel connections.  

SAVE THESE INSTRUCTIONS 

WARNING 

Explosion Hazard 
 

Keep flammable material and vapors, such as gasoline or solvents away from the STIP. 
Failure to do so can result in explosion, fire or death. 
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To ensure proper ventilation for the STIP allow at least ½” (1.25 cm) on each side. 
When installing STIP allow at least 2” (5 cm) behind the panel. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Before installing the panel in its final location, ensure you have a proper electrical 
connection.  

 
  

WARNING 

Electrical Shock Hazard 
 

Only certified service personnel should open the panel, persistent high voltage is present.  
Connect only to AC voltage as indicated on the rear panel. 
Plug into a grounded 3 prong outlet. 
Do not remove ground prong. 
Do not use an extension cord. 
Only Replace Fuses with the fuses of the same rating as indicated on the panel. 
Ensure that the AC power supply is properly grounded and hot and neutral wires are 
properly polarized before installing the panel. 
Disconnect panel power before making any rear panel connections. 
Ensure there is a sufficient ground connection present at the slip rings as the panel is 
capable of producing high voltages in excess of 400v DC. 
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1 Panels Hookups 
DEPTH CABLE 
Depth Panel 7 Pin Female     Interface Panel 7 Pin Male 
 A       A 
 B       B 
 D       D 
 F      F 
 G 
 
ENCODER CABLE 
7 Pin Male       Depth Encoder 7 Pin Female 
 A       A 
 B       B 
 D       D 
 F            F 
 G 
 
TENSION CABLE 
Depth Panel 5 Pin Female     Interface Panel 5 Pin Male 
 C       A   
 D       B 
 E       E  
 
TENSION TRANSDUCER CABLE (XPRO-HONEYWELL PRESSURE TRASMITER) 
 5 Pin Male       Pressure Transducer  
 D       1 (Excite Usually Red)   
 B       2 (Signal Usually Black) 
 A              Shield            3 (Case) 
 E 
 
 
 
 
 
 

Section 
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DC CABLE 12V DC 
3 or 2 Pin Male       Battery Truck (12 VDC)  
 A       Positive   
 B       Negative 
 C       NC 
 
LIGHTS CABLE  
4 Pin Male       Lights  
 A       Common   
 B       RED Light 
 C       GREEN Light 

D       NC 
 
 

1.1 Interface Cable Wiring 
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Fig 1.1 CPF-Plotter-CPU 
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Fig 1.2 CPF-DTLS-Plotter-CPU 
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Fig 1.3 CPF-Shooting-Plotter-CPU 
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Fig 1.4 CPF-DTLS-Shooting-Plotter-CPU 
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2 TELA Board 
2.1 TELA R6 
 
The TELA board amplifies the down-link telemetry signals. Signals from DAC0 via MuxB-2 enter at J1-26. 
IC1B is a buffer with a gain of 2 that feeds a current amplifier made up of IC1C, IC2 and IC1D. IC1D provides 
the feedback for the amp. D1 and D2 provide protection from signals over + or – 15 volts. C1 and C2 provide 
DC decoupling from the line voltage up to 400vdc. The down link can be viewed at TP1 along with the 
attenuated up-link. K1 is not present “except in upgrade panels” so there should be a jumper across pins 
12 and 14. 
 

2.2 TELA R7 
 
The TELA R7 board is similar to the R6 board with the addition IC3 MAX313 analog switch. It is used along 
with the enable line on J1-11 to enable downloads by bypassing R16 with the low impedance of the switch. 
When not in use the analog switch is disabled and R16 offers high input impedance to the line so that it 
does not attenuate signals from other services.  
 

2.3 TELAH R5 
 
The TELAH R5 board is functionally similar to the TELA R7 and R8 boards with the addition of transformer 
coupling and a slow TELA option for low frequency downlinks that bypasses the transformer. 
 
 
  

Section 
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Fig 2.1 Schematic Telah R5 
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Fig 2.2 Telah R5 board layout 
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3 Pre-Relays Board 
This board controls the flow of tool power and tool signal through the interface panel.  
The power relays board connects the line input of the tool interface panel to the rest of the circuitry in the 
panel. Functions of the card include enabling line, controlling line termination, selecting positive or negative 
power to be applied to tool, and enabling the down-link capabilities of the TELA card.  
 
3.1 Circuit Description 
 
3.1.1Line Input 
The line input from the rear panel connectors J7 and J12 connect at pin 27 to one of the contacts of relay 
K2. In the un-energized state, this connects the line to chassis ground through pin 28. When a high signal 
level is applied to pin 8 from the PSXD board, K2 is energized and the line connects to pin 26. The second 
contact of K2, which is connected to +5V connects to pin 24 to supply power to the line enable indicator on 
the interface front panel. 
 
The line connection at pin 28 connects to the Free Point board pin 12. Unless a free point service is to be 
run, a relay on the Free Point board connects the line to pin 10 of the Free Point board which returns to the 
PRELAYS board at pin 30. 
 
From this point, the line is connected to the PSXD board to measure the tool voltage and to the ANASW 
board to do pre-filtering and conditioning of signals. 
The line is also connected from pin 30 to relay K3 at pin 35. When this relay is energized, it connects to pin 
34 and allows the downlink telemetry from the TELA board to be driven onto the line. 
 
Relay K4 is used to control the line termination resistance. When K4 is not energized, the tool power passes 
through both R1 and R2. When K4 becomes energized, pin 30 connects to pin 31, shorting around resistor 
R2. 

Section 
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Resistor R1 connects to relay K1 at pin 5. Depending upon the state in which the relay is energized, either 
the positive or the negative side of the tool power supply is connected to R1. The other side of the supply 
connects through the second contact to pin 1, which goes to the PSXD board and passes through a .1 ohm 
resistor to chassis ground to measure the amount of current being supplied from the tool power supply. 
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Fig 3.1 schematic Prerelays R5 
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Fig 3.2 Pre-Relay R5 board layout 
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4 Applied Free point Board 
This board drives a sine wave down the logging cable to an Applied Electronics or SIE style Free point tool. 
The response of the tool attenuates the signal. The amplitude of the attenuated signal has a bias applied 
to it to set a zero reference point. The change in the amount of attenuation is then measured to create an 
output. 
Since the drive of the board must be directly connected to line without the effects of line termination or 
power supply load, the panel passes the line through a relay on this board to the rest of the panel circuitry 
or when engaged, connects the electronics on the board directly to the line connection.  
 

Note that the board must be in the interface panel and the K1 relay must not be 
engaged for the line to connect to the rest of the panel circuitry. 
 

The board also contains circuitry to “Set the tool” through isolated AC input, bridge rectifier and filter that 
creates a DC voltage. This voltage can then be applied to the line through a second relay. 
 
4.1 Circuit Description 
 
4.1.1 Line Input 
The line connection to the panel passes through the line enable relay on the pre-relays board when the line 
is enabled and connects to J1-12. If K1 is not energized, the line passes through K1 to J1-10, which 
connects to the tool power supply, line termination resistors, and the ANASW board. When the K1 relay is 
energized the line connects to the K2 relay which connects either to the signal driver or the DC power 
supply to set the tool. 
 
4.1.2 Line Driver and signal measurement 
Buffer U6A receives a signal from the DSP with amplitude and frequency set in the DSP script. IC2 and 
U6B form a current driver that drives the signal though R23 onto the line. D3 and D4 protect the circuitry 
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from voltages inadvertently placed on the line. Amplifier U3A rectifies the signal at TP3, which is then filtered 
and amplified by U3B and is present at TP4. 
Buffer U6C receives a DC level from the DSP, which is controlled by the zero scroll bar via software. The 
wiper of P1 can be adjusted from the negative rail voltage to the positive rail voltage. U2A sums these 
voltages together with the rectified and filtered signal at TP4. This signal is then passed through a final 
stage of filtering and amplification in U2C and U2D. 
 
4.1.3 Adjustments  
With a Free point tool on line in a relaxed state and the software zero scroll bars set to mid – range, P1 is 
adjusted for a 0.0 VDC level at TP5. 
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Fig 4.1 Schematic Applied Free point R7 
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Fig 4.2 Applied Free point R7 board layout 
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5 Power Supply Auxiliary Board 
This card receives I2C signals from the USB44 board that control the outputs of the two octal bus drivers. 
The outputs of these drivers are used as control bits to engage various relays and switches throughout the 
panel. The I2C signals also control the output of IC3, which supplies software control for the tool power 
supply. 
The card also contains the tool current sense amplifier and the line voltage divider. The outputs from these 
drive the front panel meters and are also routed to the DAC circuitry on the USB44 board.  
There is additional circuitry to control the polarity and the source of control to the tool power supply. 
 
5.1 Circuit Description PSAUX R2 
 
5.1.1 TPS Output and Polarity Control  
The I2C Clock and Data signals from the USB44 card are connected to IC5 and IC6 and drivers IC2 and 
IC7. Most of these signals are connected to edge connector and used to control various relays and switches 
throughout the panel. 
Gates IC1A, IC1B, and IC1C control the tool power supply polarity switching via the tool polarity relay on 
the PRELAYS board via J1-31.  
When the front panel switch is in the POS position, pins 1 and 4 of IC1 are grounded. Pin 8 of IC1 will be 
set low. With the switch in the NEG position pin 1 of IC1 is pulled high by R13. Pin 8 of IC1 will be set high. 
With the front panel switch in the center (NC) position, pin 1 of IC1 is held low by R10. Pin 4 of IC1 is held 
high by R12 and the signal on pin 5 now controls the output state of pin 8. Pin 5 of IC1B is connected to 
the polarity control bit of bus driver IC2. Additionally with pin 4 pulled high, U6A will take the control voltage 
from the output of the DAC IC3 and its related amplifiers rather than the front panel voltage control 
potentiometers. U6B is controlled by the output of IC1C and selects which front panel potentiometer is in 
control of the power supply when in manual mode. 
I2C data is fed into Digital to Analog converter IC3, whose output is amplified through IC4A and IC4B to 
produce the software voltage control. P6 is used to adjust the signal to 0.0 volts when the software control 
is set to 0%. P5 is adjusted to 8.0 volts when the software control is set to 100%. 
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5.1.1 Panel Voltage and Current Measurement 
The instrumentation amplifier, U1, amplifies the voltage across R5, the current sense resistor. The output 
of U2C drives the digital panel meter while the filtered output of U2B is sent to the USB44 ADC input 
channels.  
The line voltage is divided by a factor of 100 by the resistor network consisting of P2, R8, and R9. The 
output of U2A drive the voltage panel meter while the filtered output of U2D is sent to the ADC on the 
USB44 board.  
 
5.1.2 Adjustments and Jumpers 
Software Tool Power Control  
With the front panel switch in the center position, and software control set to 0%, P6 is adjusted for 0.0 VDC 
at TP1. With software control set to 100%, P5 is adjusted for 8.0 VDC at TP1. 
 
5.1.3 Voltage and Current Measurement 
P3 is used to adjust the panel voltage meter with no voltage output. P2 is used to adjust the ratio of the 
potential divider to give the correct voltage meter reading. 
The potentiometer P4 is used to zero the panel current meter with zero current flowing. The potentiometer 
P1 is used to adjust the panel meter to a known current value. 
 

5.2 PSDXDR7 BOARD  
5.2.1New Features 
 

1 Positive Current Regulator range:  0- +400mA 

2 Negative Current Regulator range: 0-  -400mA 

3 Positive Current Trip range:   0- +450mA 

4 Negative Current Trip range:  0- -450mA 

5 Positive Voltage Trip range:   0- +400Vdc 

6 Negative Voltage Trip range:  0 -  -400Vdc 

7 TVOLT Calibration Gain and Offset save in the board (EEPROM) 

8 TCURR Calibration Gain and Offset save in the board (EEPROM) 

9 Compatible with Old software and old CPF panels 

10 To Enable Line in MANUAL mode the Adjustment control knob must first be rotated fully 
counter clock wise. 

11 To Enable Line in AUTO mode the Slider bar must be in 0Vdc. 

12 Allow Instant Voltage check box to bypass the features (10-11-12-13). 



 

39 
 

 

 

5.2.2 General Description 
 

This board receives I2C signals from the USB44, which control the following: 
Pre-Relay bus board, set zero Voltage, set zero Current, Span Voltage, Span Current, TPS 
voltage control, set polarity, Line enable, Set voltage, Set Current, Maximum Voltage, 
Maximum Current, sense Output Voltage , and, sense Output  Current. 

The IC7 (AD623) senses the current by measuring the voltage across the R5 0.1Ω 
resistor. The gain of the AD623 is resistor programmed by network R7, R2, and IC8 applies a 
gain of 10. The Diodes D1, D4, D5, and D6 are high conductance ultra-fast diodes to protect 
IC7. The output of IC11D drives the digital panel meter while the filtered output of IC11B is 
sent to the USB44 ADC input channels. 

IC11, and IC6 are rail-to-rail high performance op-amps with a high CMRR, which 
makes them unique among rail-to-rail input amplifiers. Full wave rectification is provided by 
the circuit IC11A, and D2 for current, the IC11B is a buffer to connect to IC4. 

IC1 and IC8 are DS1867 Dual Digital Potentiometers 10K with EEPROM. The DS1867 
consists of two digitally controlled potentiometers having 256-position wiper settings. 
Communication and control of the device are accomplished over a 3-wire serial port SPI bus 
controlled by IC4, which allows reads and writes of the wiper position. Both potentiometers 
can be stacked for increased total resistance with the same resolution.  One potentiometer 
set the Zero Voltage and the other set the Zero current. 

IC4 PIN_84 (POL) controls the tool power supply polarity switching via the tool polarity 
relay on the PRELAYS board via J1-31.  

When the front panel switch is in the POS position, PIN_93 IC4 is grounded. PIN_93 
of IC4 will be set low. With the switch in the NEG position PIN_93 IC4 is pulled high. 
With the front panel switch in the center (NC) position, PIN_94 IC4 is held low by R19.  
The line voltage is divided by a factor of 100 by the resistor network consisting of R21, R28, 
R32, R33, and IC8. The output of IC6D drive the voltage panel meter while the filtered output 
of IC6B is sent to the ADC on the USB44 board. 

Full wave rectification is provided by the circuit IC6A, and D3 for Voltage, the IC6B is 
a buffer to connect to IC4.  

IC1 is used to adjust the panel voltage meter with no voltage output. IC8 is used to 
adjust the ratio of the potential divider to give the correct voltage meter reading. 
The potentiometer IC1 is used to zero the panel current meter with zero current flowing. The 
potentiometer IC8 is used to adjust the panel meter to a known current value. 

IC4 save TVOLT Calibration Gain and Offset save in (EEPROM1), TCURR Calibration 
Gain and Offset save in (EEPROM2), maintains the position of the wipers (IC1, and IC8) in the 
absence of power. This feature is provided through the use of EEPROM in IC4. 

IC4 set the Positive and Negative Voltage Trip V_REF value over R1. Set the Positive 
and Negative Current Trip I_REF value over R11.  

Software Tool Power Control With the front panel switch in the center position, and 
software control set to 0VDC, IC1_W1 is adjusted for 0.0 VDC at TP3. With software control 
set to 500 VDC, IC8_W1 is adjusted for 8.0 VDC at TP3. 

The IC4 Check-sum is 295B 

 
 



 

40 
 

 
 
 
 

 

 



 

41 
 

Fig 5.1 Schematic PSDXD R7 
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Fig 5.2 PSXD R7 board layout 
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Fig 5.3 Schematic PSDXD R2 
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Fig 5.4 PSXD R2 board layout 
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6 Tool Power Supply and ACSW3 
The tool power supply consists of a regulator board (TpsDR9.1), four pass transistors, two transformers, 
and the front panel controls to set positive and negative voltage levels and switch output polarity.  If the 
front panel switch is in the AUTO position then the polarity and voltage may be set under software control.  
A small DC to DC converter powers the regulator, allowing it to float on the tool voltage.  The main power 
comes from a 1:2 step up isolation transformer. The two transformers, together with the rectifier and 
smoothing capacitor are mounted on the rear chassis. 
 
6.1 Circuit Description TPSD 
 
Reference voltage from the PSAUX board enters the power supply at J5-2, it is a 0 to 8 volt input that is 
buffered and isolated by U3 a opto isolated OP amp. The output side of the amp is powered by PS1 the 
DC to DC converter. P1 is used to set the output of the power supply to 100volts dc no load with a 2.00v 
ref. The output of the power supply is fed into a voltage divider R13 and compared to the reference voltage 
at U4 pin 3 to produce a regulated output. U4 pin 6 feeds the gate of the power FET thru R1 to regulate the 
output. Power supply current flows thru R2 and R9 to produce an output voltage which when it reaches 
about .7 volts at the base of Q1 it will limit the current. This voltage is also compared to the .80 volt reference 
from P2  in 1C1A to switch U5. This output when active will clamp the power supply output thru SCR IC2. 
Once active the only way to reset the clamp is to power down the power supply. 
 

6.2 Circuit Description ACSW3 
 

The ACSW3 board is used to enable the main power transformer through AC switch THY1. This is  software 
controlled  via the I2C buss and the PSXD board. The board also rectifies the AC output with D1, D2, D3 and D4. 
This output passes through fuse F1 “ 3 amp “ and to inductor filters . 
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Fig 6.1 Schematic TPSD R10 
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Fig 6.2 TPSD R10 board layout 
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Fig 6.3 ACSW3 Schematic 
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Fig 6.4 ACSW6 Board  layout 
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7 Analog Switch Interface Board  
The analog switch board decouples the tool power voltage from the line signal input and routes it to the 
various interface boards.  The primary outputs of the card are a series of buffered signals that are connected 
to the other cards of the interface panel. In addition, the card also includes an audio amplifier circuit that is 
used to amplify the line signal with output to a loudspeaker or headphones. This function is primarily used 
with audio (noise) surveys. 
 
 

7i ANASW R16 
 

7i.1 Circuit Description 
 
7i.1.1 Line Input 
The line signal enters the card on J1-23 (CC7-23) and is decoupled from the line by capacitor C4.  Relay 
K1 is use to switch a filter in or out of the circuit thru Q3, IC4A andIC3.  Zener diodes D1 and D2 limit the 
signal to about 12 volts, peak to peak. The amplifier U2A provides high input impedance so that signals are 
passed down to a very low frequency. IC2 is a dual serial DAC. The USB controller on the USB44 card 
communicates with it on an I2C bus over the serial data (SDA) and the serial clock (SCL) lines. It converts 
the data into analog voltages that are then used to control gains of scalar U3 for audio signals. U1A, U1B, 
U1C, U1D, and U2C are unity gain buffers to provide low output impedance to the other interface panel 
boards. 
 
7i.1.2 Audio Amplifier 
The audio amplifier consists of scalar U3 that provides volume control and audio power amplifier IC1. The 
output of IC1 connects via J1 39 to the output jack and headphones or a loudspeaker.  A faceplate 
potentiometer can be configured to control the level. 
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7i.1.3 Wellhead Pressure and aux channel 
U5 and U7 were added to provide means to process a Wellhead pressure and an Auxiliary channel capable 
of processing 2 and 20 ma signals.  12 VDC current limited supplies are provided by Q1 and Q2. 
 
7i.1.4     Baker Mod 
IC3 and IC4 were added to enable control of simulator routing into the panel from pin 2 on the Aux5 
connector. 
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Fig 7i.1 Schematic Analog Switch ANASW R16 
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Fig 7i.2 Analog Switch ANASW R16 board layout 
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7ii ANASW R20 
 

7ii.1 Circuit Description 
 
7ii.1.1 Line Input 
The line signal enters the card on J1-23 (CC7-23) and is decoupled from the line by capacitor C4.  Relays 
K1 and K2 are used to switch in the HWFilter , they provide 4 options none, 234Hz, 482Hz and 723Hz 3db 
role off. The board routes the CCL signal around the HWFilter so that it is still possible to detect an analog 
CCL when the Filter is engaged.  Zener diodes D6 limits the signal to about 12 volts, peak to peak. The 
amplifier U1A provides high input impedance so that signals are passed down to a very low frequency. The 
PSOC IC4 receives IC2 commands from the USB44 to control the relays via Q5 and to provide gain slider 
controls for the speaker output. U6 provides buffered outputs to the CBL, CCL, Audio and MTT boards 
 
7ii.1.2 Audio Amplifier 
The audio amplifier consists of scalar U2 that provides volume control and audio power amplifier IC1. The 
output of IC1 connects via J1 39 to the output jack and headphones or a loudspeaker 
 
7ii.1.3 Wellhead Pressure and aux channel 
IC5 and IC6 provide a means to process a Wellhead pressure and an Auxiliary channel capable of 
processing 4 and 20 ma signals.  12 VDC current limited supplies are provided by IC2 and IC12. 
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Fig 7ii.1 Schematic Analog Switch ANASW R20  
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Fig 7ii.2 Analog Switch ANASW R20 board layout 
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8 CCL Board 
This card provides filtering and amplification of the casing collar signal when it appears as a low 

frequency signal imposed on the line or from an external source, such as a shooting panel with CCL output.  
Experience has shown that the CCL signal must be sampled at a rate of at least 20 samples per 

foot in order to obtain a detailed collar log. The sample rate default value is set in the services.ini file. 
The CCL card input is connected to the line input via the ANASW card. In addition, there is an auxiliary 
input, which is connected to a BNC connector at the rear of the STIP. This input is used to provide a passive 
CCL signal while perforating guns are being run, without the main line enable relay being activated. 

The output of the card is a filtered and amplified version of the input CCL signal, which is connected 
to the ADC on the USB44 card in the interface panel. 
 
8.1 Circuit Description 
 

This card provides 8th–order low-pass filtering (via IC3), and amplification of the casing 
collar signal when it appears as a low frequency signal imposed on the line or from an external 
source, such as a shooting panel with CCL output, additionally the signal can be routed by 
software as an Active CCL or Passive CCL. 

The PSoC (IC4) receives control signals from the USB44 via the IC2 buss to select Active 
CCL (Pin1), Passive CCL (Pin1), corner frequency, CCL gain, and CCL audio. 

The clock tunable for low-pass filter can set up with corner frequencies from 1Hz to 
20Hz. The PSoC provides the external clock that control the filter’s corner frequencies. 
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The CCL gain is controlled by IC4 and sent to the scalar U1 to increase or decrease the 
CCL signal. The scalar output (U1) sends the signal to low-pass filter (IC2). 

The output of the card (J1-27) is a filtered and amplified version of the input CCL signal, 
which is sent to the ADC on the USB44 card in the interface panel. 

The PSoC can be programmed via header SL1.The PSOC IC4 has a Check-sum = A43F 
 

 
 
 

8.2   PSoC Block Diagram  
 

The I2C Bus address is 36 (DEC)  
The PSoC receives commands via the I2C Bus from USB44 to control various functions.  
  
8.2.1PSoC Pin Out 
 
Pin1 Set control Passive/Active CCL 
Pin2 DAC output (0-5Vdc) 
Pin 3 SCL I2C Clock (100 KHz) 
Pin 4 GND 
Pin 5 SDA I2C Data (100 KHz) 
Pin 6 P0 (2) NC 
Pin 7 P0 (4) Output Freq. (100Hz or 1000Hz) this results in a corner frequency from (1 Hz to 
10 Hz) 
Pin 8 VCC (5Vdc) 
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Fig 8.1 Block Diagram CCLVF R3 
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Fig 8.2 Schematic CCLVF R3 
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Fig 8.3 CCLVF R3 board layout 
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9 i CBL1  R6 Board 
The CBL01 card conditions acoustic and analog pulse signals that are subsequently input to 
the SDSDSP card for data acquisition. The input to the card is connected to the line via the 
ANASW card. The card outputs three signal channels that are used for sonic sync pulse 
detection, analog pulse detection, and two channels of sonic signal for amplitude 
measurement, waveform recording and travel time measurement. The board has three filter 
sections that are controlled by Warrior software with the USB I2C bus to allow the greatest 
degree of flexibility for signal processing from different down-hole tools.   
 
9i.1 Circuit Description 
 
The signal comes from the ANASW board on CC7-9 and arrives on the CBL1DR5 board on 
CC9-23 (J1-23).  It goes to buffer IC2A. The buffer output drives two other buffers, IC2B 
which drives LINEB, IC2D which goes through selective filtering controlled by IC9 and then to 
buffer IC2C to become LINESON(acoustic). Signal LINEB supplies the SYNC by going to DAC 
IC11, pin 18 which controls the gain going to IC3 and IC4, two multiplying DACs, AD7628, 
configured as programmable filters.  IC3, OUTA and OUTB control the gain and Q of the filter 
made by IC6.  IC4, OUTA and OUTB control the cutoff frequency.  IC14A, DG403, selects 
either the high pass output, HPSYNC, or the band pass output, BPSYNC.   IC14B allows the 
SYNC signal to be inverted, if necessary.  The SYNC signal is buffered by IC8B and goes off 
the board on J1-12, SYNC OUT to the CBL02 board. 
 
9i.1.1 LINEB 
 
Signal LINEB also supplies the AUX signal.  It goes to pin 4 of DAC IC23 for gain control and 
on to filter controls IC15 and IC16.  The gain of the filter is controlled by IC15, OUTA, the Q 
is controlled by IC15, OUTB, and the cutoff frequency is controlled by IC16, OUTA and OUTB.  
The filter has two outputs, HPAUX, high-pass and BPAUX, band-pass.  The output is selected 
by IC18A, DG403, and analog switch.   IC18B allows inversion of the signal as needed.  The 
signal leaves the board on J1-30 and goes to the TELA board where telemetry signals are 
processed.  It also goes to DSP INP9, CC14-30. 
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The three filters are controlled by IC21, PCF8575 data register, and IC20, PCF8575, control 
register.  These devices get data from the I2C bus which comes onto the board on J1-16 and 
J1-17 from the USB44.  The filters are under software control through the USB bus and are 
set up in the tool configuration panel of the Warrior Software. 
 
9.1.2 LINESON 
 
LINESON is processed the same way by IC11, and IC1 and IC7.  The ACOUSTIC channel 
leaves on J1-18 and goes to the CBL02 on CC10-23, threshold control.  It also goes out on 
J1-10 to CC14-8, amplitude to DSP IN1. 
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Fig 9i.1 Block Diagram CBL1D R6 
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Fig 9i.2 Schematic CBL1D R6 
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Fig 9i.3 CBL1 R6 board layout 
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9 ii CBL1  R13 Board 

 
 The CBL01 R13 board conditions acoustic, pulse and telemetry signals that are 
subsequently input to the SDSDSP card for data acquisition. The input to the card is connected 
to the line via the ANASW card. The card has three outputs. The acoustic output is used  for 
sonic amplitude, travel time and waveform recording in the DSP. The Sync output is used in 
combination of the CBL_02 and DSP to synchronize SCBL signals. The AUX output is used to 
either discriminate pulse data or decode telemetry signals in the DSP. The board has three 
filter sections that are controlled by Warrior software through the USB I2C bus which allows 
a greater degree of flexibility for signal processing from different down-hole tools.   
 
9ii.1 Circuit Description 
 
 The signal comes from the ANASW board on CC7-9 and arrives on the CBL1 R13 board 
on CC9-23 (J1-23).  The signal goes through the analog switch IC25 to connect to the two 
buffers on quad op amp IC2 to output LineSon and Line B. Line B is gain controlled by scaler 
IC27. LineSon passes through analog switch IC9 to provide Sonic Pre filter selection.  
 
9ii.1.1 LINEB “ Sync “ 
 
 Line B produces the Sync output. It passes through the gain selector IC26 into the 
band pass filter controlled by IC3, IC4 and IC6. Analog switch IC1 selects via software control 
either band pass or high pass. IC4 B determines if the sync pulse is invered via software 
control. The sync output is then buffered by two stages of IC8 out pin 12 to the CBL 2 board. 
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9ii.1.2 LINESON “ Sonic “ 
 
 LineSon the sonic signal is gain selected by IC11 then routed through the band pass 
filter IC1, IC7 and IC12 to produce a software controlled output into IC13. IC13 selects via 
software either band pass or high pass filtering and optional signal inversion. The resultant 
signal is them buffered by three stages of IC24 and out pin 18 to the DSP.  
 
9ii.1.3 LINE AT “ Aux ” 
 
 The Aux signal is fed out of IC26 into a precision software controlled filter with eight 
options to optimize pulse and telemetry signals. The filter is composed of three analog 
switches selecting specific filters made up of three stage filter IC10. This optimized output is 
buffered and scaled by IC15 , IC19 and scaler IC22. The resultant output leaves on pin 30 to 
the DSP. 
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Fig 9ii.2 Schematic CBL1 R13 
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Fig 9ii.3 CBL1 R13 board layout 
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10 CBL2 Board 
The CBL02 board provides detection of positive and negative sync pulses. 
The CBL02 card receives several inputs and performs the functions of sync pulse detection.  It receives 
acoustic signal inputs from the CBL01DR card and analog and digital control signals from the DSP. The 
card outputs are positive and negative sync detection signals. 

 
10.1 Circuit Description 
 
10.1.1 Sync. Pulse Detection 
The signal from J1-12 of the CBL01 card connects to J1-3 of the CBL02 card and goes to the positive input 
of buffer U2D and the negative input of U2A.  U2D supplies comparator U1B to process positive sync 
signals, and U2A supplies U1A for negative sync signals.  The trigger level(s) of the comparator(s) are 
controlled by the DSP DAC0 signal that is connected to J1-38. This control signal is applied to the inverting 
input of U2C and then to the inverting inputs of U1A and U1B. In this way any signal appearing on J1-3 
larger in amplitude than DAC0 (either positive or negative) will result in an output pulse at either U1A and/or 
U1B. 
A potential sync pulse, having been detected in this manner, is then digitized and tested by the DSP for 
further verification. The actual level of the DAC0 signal is controlled by the DSP script (program) and may 
be varied to accommodate a variety of down-hole tools. 
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The outputs of U1A and U1B go to IC1A and IC1B, 7400 nand gate.  The other inputs to the NAND gates 
are control signals from the DSP that inhibit the interrupts to avoid false sync signals.  NEG SYNC and 
POS SYNC signals are connected to the SDSDSP board by CC10-37(J1-37) and CC10-35(J1-35).  
 

10.2 Trouble Shooting Hints 
 
10.2.1 Sync. Pulse Detection 
The normal signal may be viewed on TP3 and the output of the comparators at test points TP1 and TP2. 
Comparison of these signals will indicate the correct (or otherwise) operation of the sync-pulse detection 
circuits. 
The DSP DAC signal controlling the detection level may be viewed at pin 38 of the card edge connector. 
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Fig 10.1 Schematic CBL2 R14 
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Fig 10.2 CBL2 R14 board layout 
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11 Audio Board  
The board consists of a high pass filter with 3db point around 100 Hz followed by a low pass filter with 3 dB 
point around 20 KHz The noise board has four outputs. Maximum signal input to the DSP is +2.5 volt DC. 
With a board input of 20 volt p-p, the range1 output is 5 volt p-p, with gain of 0.25. Range2 is set with a 2 
volt p-p input with gain of 2.5. Range3 is 200 mv with gain of 25 and range4 is 20 mv with gain of 250. The 
software finds the largest signal that is not saturated and uses a Fourier transform to extract the signals in 
each frequency range. 
 
11.1 Circuit Description 
 
U8 and U9 are voltage regulators that are used to supply the signal amplifiers. They are used to remove 
any noise that might be on the panel rail supplies so that the noise does not appear on the outputs of the 
high gain amplifiers.  
The signal enters the board at J1-5 from the ANASW board. It first passes through a 100 Hz to 20 KHz 
band pass filter comprised of U1A and U1B. U2 and U6A provide the Range1 output with a gain of .25.  U3 
and U6B provide the Range2 output with a gain of 2.5. In addition U3 has an offset adjustment to eliminate 
a signal offset in the following stages. The output of U6B is also feed into U4 and U7A. This stage has a 
gain of 10, so that the effective output of Range3 is a gain of 25. The output of U7A is also feed into U5 
and U7B. This stage also has a gain of 10, so that the effective output of Range4 is a gain of 250. 
U10 and U11 are normally not installed. If the DG403 analog switches are installed in these positions, 
signals can be brought onto the board on J1-28 through J1-31 and DSP input channels normally used for 
noise can be used to process these other signals. Selection of signals would be made from software control 
on J1-25. 
 

11.2 Board Configuration 
Make Sure R5 & R8 are 20K ohm resistors 
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Fig 11.1 Schematic Audio R5 
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Fig 11.2 Audio Board R5 board layout 
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12 MTT Board  
12.1 circuit Description 

The MMT signal enters the board at J13-3, P1 sets the gain of U1A and U1B a low pass amplifier so that when 
the MTTair signal is applied there is 3.5 volts peak to peak signal present at TP2. U1C in combination with D1 
provide DC conversion. U2A buffers this DC voltage before it is summed with the reference voltage from U3. U4A 
and U4B provide a low pass filter for the DC level before it is summed with the output of the pot P3. When the 
MTTair signal is applied P3 is adjusted for zero volts out of U4C. When the MTT55 test signal is applied gain pot 
P2 is adjusted for 1.85 volts output.  
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Fig 12.1 MTT R2 board layout 
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Fig 12.2 Schematic MTT R2 
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13 USB44 Board 
13.1 Circuit Description 
 
The USB44 board contains a 16 channel ADC, two three channel counters, and the depth and tension 
processing circuitry.  When the computer is plugged into the USB port the Warrior software will recognize 
the board and download a program into the USB controller.  The controller will continuously monitor these 
devices and send the information to the PC.  The data may be viewed in the MONITOR DEVICES – 
DAMUPCI window.   
 
13.1.1 Analog Channels 
The ADC U3 is a, “AD976AR” it is a 16 bit, 5 usec device.  The signals to be digitized come from IC2, 
HI506, analog multiplexer, which allows processing of 16 channels.  Three channels are dedicated to line 
tension, tool voltage and tool current.  The rest are available for customer tool signals.  The digitized signals 
are sent to the PC by the USB controller, IC11.  There are two three channel counters, U6, and U7.  The 
Line speed and a 1MHZ clock are processed by IC6.  There are three channels are available for pulse 
tools. 
 
13.1.2 Depth Encoder Input 
The depth information comes from a quadrature encoder mounted on the measuring head. Its outputs are 
pulses that come in on J1-10 and 11 and go to IC7, LS7084, quadrature clock converter.  IC7 decodes the 
direction of cable movement which goes to IC1 as DIR and sends pulses, PPR, to the counter, U6, pin 18, 
to monitor line speed.    
 
13.1.3 Line Tension Input  
The tension signal may be a 4-20 ma current loop, R14, 24.9 ohms installed, or a strain gauge, with C36 - 
2uf installed.    The signal is amplified by U5 and digitized by U3 channel 6.  The USB controller, IC1, sends 
the depth, line speed, direction and tension information to the PC. 
Pull-up resistors, R16 and R17, are provided for encoders with open collector outputs.  J2, J6 and J7 are 
used to select 5 or 12 volt encoder operation.  K1 supplies 12 volts to regulator U1. 
When the SDS Depth and Line Tension Panel are present the line tension signal, line speed and direction 
information is generated by this panel and routed to the PC directly on the USB bus.  
 
13.1.4 USB Operation 
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IC1, the USB controller, is connected to the USBHUB through J1-14 and 15. IC5 contains the identity code 
for the board so that the Warrior software can identify it and download the proper software into the memory 
on IC1.  The controller is constantly monitoring the counters and the ADC channels.  The one MHZ is used 
as a time base to scale the counts.  The controller communicates with the serial DAC’s on Analog Switch 
Board over the I2C serial bus to J1-16 and 17. IC6 is a regulator for the 3.3 volts needed by IC1.  IC11 
decodes the address for the serial Mux, IC2 selecting the channel to be read by the ADC, U3. 
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Fig 13.1 Block diagram USB44 Board 
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Fig 13.2 Schematic USB44 R7 
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Fig 13.3 USB44 R7 board layout 
 

 
 
 
 



 

106 
 

 
 
 
 

  



 

107 
 

 
 
 
 
 
 
 
 

 

 

14 DSPAUX Board 
14.1 DSPAUX R4  
 
This board contains the signal processing hardware for the DSP. Acoustic signals are digitized and sent to 
the DSP board where they go to the host computer via the USB port. The ADC is a 12 bit, 1.25 mega 
samples per second device which allows a maximum sample rate of about one sample per microsecond.  
Analog signals, IN1 to IN16, come in on the bottom edge connector, J1, and are routed to IC5, HI516, 
analog multiplexer, which selects one channel for the DAC IC2, MX7847JN and then on to the ADC IC1, 
LT1410.  The DAC provides variable gain for the ADC. The other DAC channel and both channels from 
DAC IC3 go out J1 to control gains and filtering on other boards.  
The DSP communicates with the ADC through IC9, M4A5-64/32 – FPGA, which contains logic to send 
#CONVST to start a conversion when #BUSY goes high indicating the ADC is ready. The digitized word is 
put on the data bus, D (0-11), and goes to FIFOs, IC13 and IC14, 64K x 9, where it is converted to a 16 bit 
word.  The data goes to the DSP over the XD (0-15) bus from J2, 40 pin header connector which is 
connected to the DSP board. The DSP board passes the data to the PC over the USB bus.  
The DSP communicates with the DACs over the XD bus. IC16 decodes the chip select signals for the two 
DACs. IC11, IC12 and IC15 allow communication via the board edge connector, J1, to other boards in the 
STIP. These are used control things like signal polarity and sync polarity.  
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Fig 14.1 Schematic DSPAUX R4 
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Fig 14.2 DSPAUX R4 board layout 
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15 DSP Board 
This card contains a TI DSP which does signal processing tasks to free up PC resources. When a service 
is selected software for it is downloaded to the DSP external memory over the USB bus. Signal gain and 
filtering are controlled from here. Pulse, CBL and Telemetry signals are processed here.  
 
15.1 Series R3 Boards  
The early boards use Tyco power supplies to derive the 3.3 volts and the 1.8 volts for the DSP. The 1.8 
supply requires a resistor to set the voltage.  
 
15.2 Series R4Boards  
The DSP is a TI TMS320C6201GJC200.  It is a 352 pin BGA device which is soldered to an adapter so it 
can be plugged into a socket on the board.  
Communication with the board is handled by U15, CY7C64603, USB controller. IC9, M4A3-64/32 FPGA 
routes control signals to various destinations.  IC7, 24LC00P, contains the address of the board so the 
Warrior software knows what it is and downloads the right data. Each USB device has a unique code except 
the hub, which is operated as a generic device because it requires no programming. IC8 is a noise 
suppressor for the USB bus.  
U3 and U4 make up 8 MB SDRAM memory for the DSP. IC4 and IC5 make up a 32 bit data transceiver to 
receive data from the DSPAUX board from J6. The A to D convertors are 12 bit so data is converted to 32 
bit for the DSP.  
 
 
 

Section 



 

114 
 

 
 

 
 
Fig 15.1 Schematic DSP R10 
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Fig 15.2 DSP R11 board layout 
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16 USBHUB Board 
The STIP-F is designed to be operated with a laptop PC over a USB port.  The panel has a built in 13 port 
USB 2 hub. The Hub also has two RS232 ports and two RS485 ports. The USBHUB board is mounted in 
the back of the STIP.  It has one up-link port and seven downlink ports.   The up-link port is connected to 
both the front and the rear of the STIP.  Relay K1 disconnects the back port when the front one is used.  
The five volts supplied by the host USB cable energizes the relay.  If the PC does not supply this voltage it 
will be necessary to use the back port.   
IC1 and IC19 form the backbone of the USB controller.  As it is a 3.3 volt device IC22, MAX882, voltage 
regulator, supplies this from the five volt supply.  The ECLAMP212’s are noise suppressors for the various 
ports.   The downlink ports provide five volts as needed.   
There is a dedicated port for the Warrior Software dongle.  There are 5 ports used to connect internal 
devices such as the USB44 board and the DSP board and are not available externally.  Five ports are 
available for external devices such as the Warrior Depth and Tension panel, and plotters which may be 
operated with a USB to serial cable. The plotter port J7 stays active when the panel is powered down so 
that printing is still available. 
The USBHUB is operated as a generic device because it requires no programming.  When the PC is 
plugged into the STIP-F there will be a momentary pause as the Warrior software recognizes the internal 
devices and downloads the software necessary to operate them. 
There is a jumper JP1 that allows the hub to be buss or self-powered, the default is buss powered. There 
is also a jumper that will tie the digital ground to the panel ground for if required. 
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Fig 16.1 Schematic USB2 R18 Hub  
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Fig 16.2 USB2 R18 Hub board layout 
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17 Simulator Box 
The USB Simulator connects to the USB port of the system pc and receives 5-volt power up to 500ma from 
it.  Tool waveforms can be downloaded and then played back in analog form through the line or directly into 
the system.   Outputs to test the Depth Encoder and Tension are also provided. 
 
 

 
FIG: 17.1 Simulator 

When the USB Simulator is powered up by plugging it into the USB port of a PC or the USB HUB of a 
Warrior Interface panel, it goes through a two-step enumeration according to the device code found on 
EPROM IC5.    Double clicking the SIMULATOR icon in the Warrior panel will bring up the control window.   
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FIG: 17.2 Simulator Controls 

Select LOAD and choose the tool waveform from a list.  These files are located in the Warrior Bin 
directory. 
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FIG: 17.3 Simulator tool files 

 
FIG: 17.4 Power Control 
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FIG: 17.5 Outputs 

 
 
To playback the waveform press the START button. 
 
There are slides for Encoder Speed and Output Gain.  The Encoder speed will depend on what number is 
input for pulses/foot.  120 should give a reasonable range.  If less speed is needed change the number to 
600 pulses per foot.  There is a button for high and long range.  Low range will provide speeds less than 
100 feet per minute.  There is a button for changing the direction, up/down. 
 
The Depth Encoder power from the interface panel lights an LED or both if it is twelve volts.   
 
 
17.1 Circuit Description 
 
The simulator gets its intelligence from IC1 – a Cypress AN2131Q EZ-USB controller with 8k of internal 
ram.  An external 128k x 8 static ram, IC2 - CY71019B – is used to store waveform data.  IC5 - 24LC00P, 
EPROM is used to store the USB address code so the device enumerates as a Simulator and not as 
something else. 
 
IC6 provides 3.3 volts for most of the logic from the USB 5 volt supply.   A DC-DC Converter supplies +/- 
12 volts from the 5 volts supplied by the USB port.  An external 5-volt supply can be used if it is needed. 
 
The encoder frequency is set by OUT0 from DAC, MAX519.  The DAC output goes to a voltage divider to 
reduce the 0 to 5 volt swing to 0 to 1 volt for the V to F converter, IC10, AD654.  Software controls the high 
and low range of the encoder speed.  The output frequency goes to IC9B, buffer, and then is split and one 
side inverted.  One side goes to IC12A, and the other to IC12B, SN74LS74, dual D flip flop.  These are 
wired to give two wave trains 90 degrees apart.  The A signal goes to Encoder Out A.  The B side goes to 
IC9A where PA5 sets direction.  When PA5 is changed the output of IC9A will be inverted.  That is how 
UP/DOWN is controlled.  The signal then goes to Encoder Out B.  IC7 and IC8 test the ENCODER voltage, 
lighting one led if it is five volts or both LEDs if it is twelve volts.  The encoder pulses are derived from the 
supply voltage.  A 5 volt supply produces 5 volt pulses and a 12 volt supply produces 12 volt pulses. 
 
SDA and SCL from IC1 control the DAC.  IC4 address lines: 01000000 address byte. 
 
PA6 controls IC14, DG411, switch.  It connects R32 for 20ma and disconnects it for 2ma.  The 12 volts 
from the STIP is converted to a current by IC7, LM317 to furnish the output signal.   The circuit will accept 
a 24 input also. 
 
The data loaded into the ram, IC2, is sent to the DAC a byte at a time and reproduces whatever waveform 
has been recorded.  The chip enable comes off A15 to allow memory paging.  It is inverted.  Write enable 
and out enable are active low.  A15 is used because we are only interested in high addresses.   A16 comes 
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from PC1/TXDO.  R36 was added to shift the DC offset of the DAC to zero.   The signal is sent from the 
DAC to U2A, TL082P, op amp, and then to U3, AD633, and voltage multiplier, through a 1K resistor.  The 
multiplier voltage is supplied by IC4, serial DAC, and OUT1, which set the output gain.  The signal then 
goes to U2B and IC3, BUF634, op amps to the line out connector. 
 
 
Cable to Encoder and Line Weight: 
 
17.2 SIMULATOR Hookups 
  
5 PIN MALE - Tension -------------------------Interface Panel    
 
A – TENSION SIGNAL GROUND REF ----------A 
B – TENSION SIGNAL OUT -----------------------B 
C –  tied to E   ------------------------------------------C 
D – +12 VOLTS IN------------------------------------D 
E – GROUND ------------------------------------------E 
 
7 PIN MALE – Depth Encoder 
  
 A – ENCODER-A 
 B – ENCODER-B 
 C – N/C 
 D – ENCODER POWER IN  
 E - GROUND 
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FIG: 17.6 USB SIM R2 board layout 
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FIG: 17.7 USB SIM R2 Schematic 
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18 Recorder 
18.1 Warrior Line Signal Recorder Service 
With the Recorder service, it is possible to make a recording of the line signal with minimal filtering. The 
recording can then be used to make a Simulator file to play back into the system through the Scientific Data 
Systems Simulator Box. Or the recorded file can be sent to Scientific Data Systems to check the tool 
telemetry or set up a new service for the tool telemetry. The recorder service is not normally installed as 
one of the default services. The service can be imported through the Service Editor.  

 
FIG: 18.1 Select Edit logging Details 
 
To install the Service Editor, go to Warrior Utilities and click on [Edit Logging Service Details]. To Import 
the Recorder Service, Click on Service ->Import. From the Warrior\Config folder, choose the CH USB 
70.WSV file and click the [ Open ] button. From the service import list, choose the Recorder service. It will 
then be added as the last service in your active service list. The Service Editor and Utilities can now be 
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closed. If Acquisition is open, it will have to be closed and then reopened before the Recorder service will 
be available. 
 
 

 
FIG: 18.2 Service\Import 
 
 

 
FIG: 18.3 Import Recorder service 
 
To make a line recording, start Acquisition and select Service -> Recorder. When the Tool String editor 
comes up, click [Save] or [Exit], there are no tools to select or edit. In the Acquisition window click on Action 
-> Power Control and enable the line in the normal manner. Adjust tool power for proper operating voltage 
and current for the tool that you are using. The Recorder Threshold window will show a sample of the signal 
that will be recorded. No adjustments are necessary in the Recorder Threshold window. 
 
 

 
FIG: 18.4 Recorder  
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FIG: 18.5 Set up Signal Recorder 
 
There are two other windows that come up when the Recorder service is started. These are the Panel 
Controls window and the Signal Recorder Setup window. The Panels Controls are not normally used unless 
the default Input Channel is changed from 15 to a channel that corresponds to the Sync, Aux, or Sonic input 
channels. This will be discussed further later. 
 
There are 4 settings in the Signal Recorder Setup window that can be adjusted. If any of these settings are 
changed, the [Apply Settings] button must be clicked before the recording is done; otherwise the original 
settings are used. 
The Input Channel is the selected DSP input channel (0 to 15). These channels are hard wired within the 
Warrior Interface Panel. Channel 15 comes from the ANASW board. The signal has been capacitive 
decoupled from the line and ran through a buffer. It is as true a raw signal as the system can digitize.  
The Sample Rate is how often the DSP will digitize the incoming signal. A 5us rate is appropriate for most 
recordings. It should not be set to lower than 3us. 
Signals may be attenuated on the DSP before they are digitized. Before doing a recording, the Attenuation 
setting should be adjusted to maximize the signal in the Recorder Threshold Window. The signal should 
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not go to the top or the bottom of the window. The smaller the Attenuation setting value, the larger the 
signal will be. An Attenuation of 100 will not show any signal and will not give a usable recording. 
The record time is the number of seconds that the signal is recorded.  
 
When settings have been adjusted as needed and the [Apply Settings] button has been set, the next step 
is to click the [Record] Button. You will need to select a file name to save the file. It is recommended that 
the file extension show the sample rate so that the file can be played back at the appropriate rate to give a 
valid recording such as 5us for a 5-microsecond sample rate. Once the [Save] button is clicked, the 
recording will start and continue for the number of seconds set in the Record Time setting. The Record 
Time will count down showing the number of seconds left to record until the recording is complete. 

 
 
 

FIG: 18.6 Save the Recorder signal 
 
 
The following is a list of the Hard Wired DSP channels in the SDS Interface Panel. 
 

Input Channel Signal Note 
0 Sonic Amplitude Configurable Filter 
2 Audio X10  
3 Audio X1  
4 Sync / Pulse Configurable Filter 
5 Audio X.1  
6 Audio X.01  
8 AUX Configurable Filter 

15 ANASW Signal Recorder Default  
 

18.2 Converting Recordings to SDS Simulator Box Files 
The recording must first be converted from a DSP recording to a WAV file and then the file must be edited 
to fit a format needed by the simulator box.  
In Warrior\Bin32 is SIMConvert.exe that will read in a recording and write a WAV file. Click on the [Load O 
scope File] button to select the DSP recording. After loading the file and before writing the 8 Bit Wave file, 
be sure that the sample period matches the sample rate done during the recording. For simple recordings, 
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the difference in the Start Sample and Stop Sample should be less than 128000, since this is the maximum 
number of samples the Simulator box can hold. Click the [Write 8 bit Wave] button to write the file. If this is 
a simple file, it can be saved with a .SIM extension and used directly by the Simulator Box. 
 
  

 
FIG: 18.7 SIM convert 
 

 
FIG: 18.8 Open  

 
 

 
 

FIG: 18.9 Save As 
 
With more complex recordings, it may be necessary to use a Wave Editor to view and modify the recording 
before converting it to a simulator file. The Warrior software does not include a waveform editor, but there 
are many free editors available through the Internet. The following Internet link is a down load for a very 
versatile editor - HTTP: //www.yamahasynth.com/download/twe.html. 
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If the signal being recorded has a periodic rate, the waveform should be edited to start before a given point 
in the period of the signal and to end before the same point at a number of cycles later in time and keep 
below the 128,000-sample limit of the Simulator Box. The waveform editor could also be used to adjust the 
amplitude of the recording or insert or enhance features in the recording, such as gamma pulses in a bond 
tool recording. 

19 CPF Wiring Diagrams 
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Fig 19.1 CPF Block Diagram 
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Fig 19.2 CPF Wiring Diagram 
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Fig 19.4 CPF Front Panel Wiring Diagram 
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Fig 19.4 CPF Power Supply Wiring Diagram 
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Fig 19.5 CPF Flow Chart 



 

158 
 

 
Fig 19.6 CPF Line Out Routing 
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20 Wire List for STIP-F USB 
       
Wire list for STIP-F USB -      
(H)Halliburton     
(B)Baker      
Single conductor Tool Interface Panel   
5/17/2018      
       
BACK PANEL ASSEMBLY     

       
       
JAC - AC Input       

 JAC-1 J41-4   BLUE {S1-2} AC Neutral 

 JAC-2 F1-1   BLACK   AC Line 

 JAC-3 TB1-1L   GREEN   Ground 

       
F1 - Main Power (3 Amp)     

 F1-1 JAC-2   BLACK   AC Load 

 F1-2 J41-6   BLACK {S1-4} Fused AC Load 

       
F2 - Encoder Power (.5 Amp)    

 F2-1 J8-D (H)J8-J  BLACK   Fused Encoder Power 

 F2-2 CC13-9    BLACK   Encoder Power 

       
J6 - Tension Input     

 J6-A CC13-38     (BLK) 
Line Tension Input 
Negative 

 J6-B CC13-40     (RED) 
Line Tension Input 
Positive 

 J6-C           

 J6-D CC13-12       
Line Tension +15V 
Excitation 

 J6-E CC12-20     (SHLD) Ground 

              

Section 
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(H)J6 - Tension Input     

 (H)J6-A CC13-38     (BLK) Line Tension Signal- 

 (H)J6-B CC12-20     (SHLD) Ground 

 (H)J6-C CC13-12       
Line Tension +15V 
Excitation 

 (H)J6-D           

 (H)J6-E CC13-40     (RED) 
Line Tension Input 
Positive 

 (H)J6-F           

 (H)J6-G CC13-18       Cal Relay  

 (H)J6-H           

 (H)J6-J (H)J8-LUG       Shield 

 (H)J6-K           

       
WHP1 - Well Head Pressure #1 {Not Normally Installed}  

 WHP1-A CC7-11   WHITE (BLK) 
-(4-20MA) Input 
Negative 

 WHP1-B CC7-10   
WHITE 

(RED) 
+(4-20MA) Input 
Positive 

 WHP1-C     
 

    

 WHP1-D CC7-8   
WHITE 

  
WHP1 +15V 
Excitation 

 WHP1-E CC7-20   WHITE (SHLD) Ground 

       
WHP2 - Well Head Pressure #2  {Not Normally Installed}  

 WHP2-A CC7-14   WHITE (BLK) 
-(4-20MA) Input 
Negative 

 WHP2-B CC7-13   WHITE (RED) 
+(4-20MA) Input 
Positive 

 WHP2-C           

 WHP2-D CC7-18   WHITE   
WHP2 +15V 
Excitation 

 WHP2-E CC7-42   WHITE (SHLD) Ground 

       

       
J7 - Line UHF Connector     

 J7 CC2-27 J12 BLACK   
Logging Cable 
Connections 

   
Connect Shield to J7 
Lug         

       
J12 - Line BNC Connector     

 J12 J7 {CC2-27}     
Logging Cable 
Connections 

             

J16 - CCL Passive Input BNC    

 J16 CC8-7   WHITE   Passive CCL Input 
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J8 - Encoder Input     

 J8-A CC13-11       Encoder Phase A 

 J8-B CC13-10       Encoder Phase B 

 J8-C           

 J8-D F2-1   BLACK   Fused Encoder Power 

  F2-2 CC13-9 BLACK   

 J8-E           

 J8-F J8 GND LUG    GREEN   Ground 

 J8-G J8 GND LUG    GREEN   Shield Ground 

 J8-LUG 
Connect Shield from J8-A&B to Connector screw 
   GREEN     

        
(H)J8 - Encoder Input     

 (H)J8-A CC13-11       Encoder Phase A 

 (H)J8-B CC13-10       Encoder Phase B 

 (H)J8-C           

 (H)J8-D           

 (H)J8-E           

 (H)J8-F J8 GND LUG       Ground 

 (H)J8-G           

 (H)J8-H           

 (H)J8-J F2-1       Fused Encoder Power 

 (H)J8-K           

 (H)J8-L J8 GND LUG       Shield Ground 

 (H)J8-M           

 (H)J8-LUG (H)J6-J         

   Connect Shield from (H)J8-A&B to J8 GND LUG   

       
AUX1 - LLM or -10 to +10 Analog Signal   

 AUX1 CC13-25    WHITE     

       
AUX4 - Auxiliary Inputs     

 AUX4-2 CC13-2   WHITE   BASE - 15 

 AUX4-3 CC13-3   WHITE   BASE - 14 

 AUX4-4 CC13-4   WHITE   BASE - 13 

 AUX4-5 CC13-5   WHITE   BASE - 12 

 AUX4-6 CC13-6   WHITE   BASE - 11 

 AUX4-9 CC13-34   WHITE   CTR4 

 AUX4-10 CC13-35   WHITE   CTR3 

 AUX4-21 CC1-19   BLACK   +5V 

 AUX4-22 CC1-20   GREEN   GND 

 AUX4-23 CC1-21   BLACK   -15V 

 AUX4-24 CC1-22   BLACK   +15V 

FN2 - Rear Fan      

 FN2-1 TB1-3L       AC Neutral 

 FN2-2 TB1-5L       AC Line 
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Top RS232        

 3 HUB_J18-1  WHITE  Tx Typically “C” 

 2 HUB_J18-2   WHITE  Tx Typically “C” 

 5 HUB_J18-3   GREEN  GND 

       

Middle RS232       

 3 HUB_J18-4   WHITE  Tx Typically “A” 

 2 HUB_J18-5   WHITE  Tx Typically “A” 

 5 HUB_J18-3   GREEN  GND 

       

RS485       

 1 HUB_J16-4   WHITE  D+ Typically “B” 

 2 HUB_J16-5   WHITE  D- Typically “B” 

 6 HUB_J16-2   WHITE  D+ Typically “D” 

 7 HUB_J16-3   WHITE  D- Typically “D” 

 5 HUB_J16-1   GREEN  GND 

       

       

       

USB Hub      

HUB J9 - To USB44     

 HUB_J2-1 CC13-20     {Shield}   

 HUB_J2-2 CC13-15     {Red}   

 HUB_J2-3 CC13-14     {Black}   

 HUB_J2-4           

        
HUB J10 - To DSP     

 HUB_J3-1 DSP_J5-1     {Shield}   

 HUB_J3-2 DSP_J5-3     {Red}   

 HUB_J3-3 DSP_J5-4     {Black}   

 HUB_J3-4           

       
HUB J1 - Sondex Ultralink     

 HUB_J4-1 SDX_J5-1     {Shield}   

 HUB_J4-2 SDX_J5-3     {Red}   

 HUB_J4-3 SDX_J5-4     {Black}   

 HUB_J4-4           

             

HUB J15 J4 J2 - Spare     

 HUB_J4-1           

 HUB_J4-2           

 HUB_J4-3           

 HUB_J4-4           
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HUB J7 - Hub Power     

 HUB_J9-1           

 HUB_J9-2 CC13-42   GREEN   GND 

 HUB_J9-3 CC13-41   BLACK   +5V 

 HUB_J9-4           

       
HUB J8 - FacePlate USB     

 HUB_J10-1 J48-BLK         

 HUB_J10-2 J48-GRN         

 HUB_J10-3 J48-WHT         

 HUB_J10-4 J48-RED         

             

HUB J16 - 
RS232 

 

 
     

 HUB_J16-1 Top RS232 3  WHITE  Tx Typically “C” 

 HUB_J16-2 Top RS232 2  WHITE  Tx Typically “C” 

 HUB_J16-3 Both Ports  GREEN  GND 

 HUB_J16-4 Top RS232 3  WHITE  Tx Typically “A” 

 HUB_J16-5 Top RS232 2  WHITE  Tx Typically “A” 

HUB J18 – 
RS485 

 

      

 HUB_J18-1 RS485 5  GREEN  GND 

 HUB_J18-2 
RS485 6 

 WHITE  D+ Typically “D” 

 HUB_J18-3 
RS485 7 

 WHITE  D- Typically “D” 

 HUB_J18-4 
RS485 1 

 WHITE  D+ Typically “B” 

 HUB_J18-5 
RS485 2 

 WHITE  D- Typically “B” 

       

(B) AUX5 -PFC Input     

 AUX5-2 CC7-29       PFC Signal 

 AUX5 Lug (CC7-29) Shield       Shield 

 
 
       

(H) J1 -Extermal Power     

 J1-A TB1-2R       Ground 

 J1-B CC2-2       EXT Power High 

 J1-C           

 J1-D           

 J1-E CC2-3       EXT Power Low 
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Sondex Ultralink Wiring     

SDX_J5 - Sondex USB     

 SDX_J5-1 HUB_J4-1     {Shield}   

 SDX_J5-2           

 SDX_J5-3 HUB_J4-4     {Red}   

 SDX_J5-4 HUB_J4-3     {Black}   

 SDX_J5-5           

       
SDX_J1 -       

 SDX_J1-1 TB1-1L    GREEN   Ground 

 SDX_J1-2           

 SDX_J1-3           

 SDX_J1-4 CC2-39    BLACK   Tool Power 

             

SDX_SKT1 - Sondex Signal    

 SDX_SKT1 CC2-17         

       
SDX_J12 - Sondex DC Supply Power    

 SDX_J12-1 TPSD-J5-2 {PS2-S-} BLACK    -15V 

 SDX_J12-2         

 SDX_J12-3 TPSD-J5-4 {PS1-S+} BLACK    +5V 

 SDX_J12-4 TPSD-J5-3 {PS3-S-} GREEN   GND 

 SDX_J12-5 TPSD-J5-1 {PS3-S+} BLACK    +15V 

       

       

HORIZONTAL PLATE ASSEMBLY    
       
TB1       

 TB1-1L JAC-3 SDX_J1-1 GREEN   Ground 

 TB1-1R TB1-2R J60-2 GREEN   Ground 

 TB1-2L T1-Lug   GREEN   Ground 

 TB1-2R TB1-1R   GREEN   Ground 

 TB1-3L FN2-1 J41-1 BLUE   AC Neutral (Switched) 

 TB1-3R TB1-4R J60-1 BLUE   AC Neutral (Switched) 

 TB1-4L T1-P1 BLK T1-P2 RED    AC Neutral (Switched) 

 TB1-4R TB1-3R TB3-7R {FN3-1}   AC Neutral (Switched) 

 TB1-5L FN2-2 J41-3 BLACK   AC Line (Switched) 

 TB1-5R J60-3 ACSW3-ACIN BLACK   AC Line (Switched) 

 TB1-6L T1-P1 BRN T1-P2 ORG    
Switched Tool Power 
Primary 

 TB1-6R TB3-6R {FN3-2} BLUE   
Switched Tool Power 
Primary 

 TB1-7L T1-S1 GRN ACSW3-ACIN    
AC Tool Power 
Secondary (1) 

 TB1-7R ACSW3-ACOUT      
AC Tool Power 
Secondary (1) 

 TB1-8L T1-S1 YEL      
AC Tool Power 
Secondary (2) 

 TB1-8R ACSW3-ACOUT      
AC Tool Power 
Secondary (2) 
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J60 - AC Power to DC Supplies    

 J60-1 TB1-3R   BLUE   AC Neutral (switched) 

 J60-2 TB1-1R   GREEN   AC GND 

 J60-3 TB1-5R   BLACK   AC Line (switched) 

       
T1 - Tool Power Transformer    

 T1-P1 BLK TB1-4L      Primary 1 Black 

 T1-P1 BRN TB1-6L      Primary 1 Brown 

 T1-P2 RED TB1-4L      Primary 2 Red 

 T1-P2 ORG TB1-6L      Primary 2 Orange 

 T1-S1 GRN TB1-7L      Secondary 1 Green 

 T1-S2 YEL TB1-8L      Secondary 1 Yellow 

 T1-S3 BLU   N/C     Secondary 1 Blue 

      

ACSW3      

 ACSW3-IN TB1-5R   BLACK   AC Line 

 ACSW3-IN TB1-6R   BLUE   
AC Tool Power 
Primary 

 ACSW3OUT TB1-7R      
AC Tool Power 
Secondary  

 ACSW3OUT TB1-8R      
AC Tool Power 
Secondary  

 ACSW3-R+ J42-17   BLACK   Switched Line Enable 

 ACSW3-R- CC4-20   GREEN   Ground 

 ACSW3-C+ C1(+)   BLACK   DC Voltage HIGH 

 ACSW3-C+ TB3-2R {R3} BLACK   DC Voltage HIGH 

 ACSW3-C- C1(-)   BLACK   DC Voltage LOW 

 ACSW3-C- TPSD-J2-NEG   BLACK   DC Voltage LOW 

       
R1 - 150 Ohm Termination     

 R1-1 R2-1 {CC2-31} BLACK  (H)L1-1   

 R1-2 CC2-37   BLACK     

            

R2 - 150 Ohm Termination     

 R2-1 R1-1 CC2-31 BLACK     

 R2-2 CC2-35 
{CC2-30}, {CC3-10}, 
{CC6-1}, {CC7-23} BLACK   Line input 

            

       
(H)L1 -35mh      

 L1-1 R1-1 CC2-31      

 L1-2 CC2-35 
{CC2-30}, {CC3-10}, 
{CC6-1}, {CC7-23}    Line input 

       

       
C1- 320uf @ 450 VDC     

 C1(+) ACSW3-C+   BLACK     

 C1(-) ACSW3-C-   BLACK     
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TPSD - Tool Power Supply Regulator   
       
TPSD - J1      

 J1-1 CC6-38   WHITE   TPSD Voltage Control 

 J1-2 CC8-17   WHITE   SDA - I2C Data 

 J1-3 CC8-16   WHITE   SCL - I2C Clock 

            

TPSD - J2      

 J2-1/2 CC2-6   BLACK   TP High Side  

 J2-2/1        TP High Side  

 J2-3/4 ACSW-C-   BLACK   TP - Low Side 

 J2-4/3 CC2-25   BLACK   TP - Low Side 

 
TPSD - J3      

 J3-1 TPSD-J3-2 (B)J65-3 BLACK  {(B)S4-5} PFC Limit Switch 

 J3-2 Q1-S TPSD-J3-1 BLACK  (B)J65-1 
omit J3-1 and 2 
jumper for Baker 

 J3-3 Q1-G        

            

TPSD - J5      

 J5-1 PS1-S+ SDX_J12-3 BLACK   +5V 

 J5-2 PS3-S- SDX_J12-2 GREEN   GND 

 J5-3 PS2-S- SDS_J12-5 BLACK   -15V 

 J5-4 PS3-S+ SDX_J12-1 BLACK   +15V 

       
Heat Sink  - Q1      

 Q1-S TPSD-J3-2   BLACK     

 Q1-G TPSD-J3-3   BLACK     

 Q1-D TB3-1R {ACSW3-C+} BLACK     

       
Fan #3 - Heat Sink Fan     

 FN3-1 TB3-6R        

 FN3-2 TB3-7R        

   
   
   
VERTICAL PLATE ASSEMBLY    
       

       
P60 - AC Power to DC Supplies    

 P60-1 PS1-1   BLUE   AC Neutral 

 P60-2 PS2-S+   GREEN   AC GND 

 P60-3 PS1-2   BLACK   AC Line 

          

TB3       

 TB3-1 R3-2 Q1-D BLACK   DC to Pass FET 

 TB3-2 R3-1 ACSW3-C+ BLACK   DC Supply 
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 TB3-3          

 TB3-4          

 TB3-5          

 TB3-6 FN3-1 TB1-6R    
Switched Tool Power 
Primary 

 TB3-7 FN3-2 TB1-4R    
120V Switched Tool 
Power Primary 

 TB3-8          

       
R3 - 50 Ohm      

 R3-1 TB3-2L   BLACK   
DC to Pass 
Transistors 

 R3-2 TB3-1L   BLACK   DC Supply 

            

PS1 - (+)5 Volt Supply     

 PS1-1 P60-1 PS1-3 BLUE   AC Neutral (Switched) 

 PS1-2 P60-3 PS1-4 BLACK   AC Line (Switched) 

 PS1-3 PS2-1 PS1-1 BLUE   AC Neutral (Switched) 

 PS1-4 PS2-2 PS1-2 BLACK   AC Line (Switched) 

 PS1-S+ CC11-19 CC13-19 BLACK 

TPSD-J5-
1 
DSP_J2-
1 +5 Volt 

 PS1-S- PS2-S+ CC13-20 GREEN 

GND 
LUG 
DSP_J2-
2 Ground 

       
PS2 - (-)15V Supply     

 PS2-1 PS1-3   BLUE     

 PS2-2 PS1-4   BLACK     

 PS2-3 PS3-3   BLUE     

 PS2-4 PS3-2   BLACK     

 PS2-S+ P60-2 PS3-S- PS1-S- GREEN CC11-20 Ground 

 PS2-S- CC10-21 TPSD-J5-3 BLACK   -15 Volt 

 
 
       

       
PS3 - (+)15V Supply     

 PS3-1 PS3-3   BLUE     

 PS3-2 PS2-4   BLACK     

 PS3-3 PS2-1   BLUE     

 PS3-4  PS3-2   BLACK     

 PS3-S+ CC10-22 TPSD-J5-4 BLACK   +15 Volt 

 PS3-S- PS2-S+ TPSD-J5-2 GREEN   Ground 
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CARD CAGE ASSEMBLY     
       
CC1 – TELA      

 CC1-11 CC14-35   WHITE   

Down link 
termination 
control 

 CC1-16 CC3-16   WHITE   I2C Clock 

 CC1-17 CC3-17   WHITE   I2C Data 

 CC1-19 CC1-41 CC2-41 BLACK   +5V 

 CC1-20 CC1-42 CC2-42 GREEN   GND 

 CC1-21 CC1-43 CC2-43 BLACK   -15V 

 CC1-22 CC1-44 CC2-44 BLACK   +15V 

 CC1-23 CC2-34   BLACK   
TELA Downlink 
to Line 

 CC1-26 CC14-31   WHITE   

Downlink 
Telemetry (DSP 
DAC2) 

 CC1-41 CC1-19 AUX4-21 BUSS   +5V 

 CC1-42 CC1-20 AUX4-22 BUSS   GND 

 CC1-43 CC1-21 AUX4-23 BUSS   -15V 

 CC1-44 CC1-22 AUX4-24 BUSS   +15V 

       
CC2 – PRELAYS      

 CC2-1 CC6-2   BLACK   (I Meas In+) 

 CC2-2 (H)J1-B      
(H) EXT Power 
High 

 CC2-3 (H)J1-E      
(H) EXT Power 
Low 

 CC2-5 CC2-38   BLACK   
Tool Power to 
Sondex Relay 

 CC2-6 TPSD-J2-2 {TPSD-J2-1} BLACK   TP High Side  

 CC2-7 CC6-32   WHITE   

TELA Enable 
Control - 
I2CInit=21=10 

 CC2-8 CC6-37 {J42-18} WHITE   
Tool Power Gate 
- I2CInit=21=40  

 CC2-9 CC6-35   WHITE   
Low Termination 
- I2CInit=21=02 

 CC2-10 CC6-31  WHITE   
Polarity Control - 
I2CInit =21=20 

 CC2-13 CC13-13   WHITE   

Load Cell Cal 
Drive - 
I2CInit=22=02 

 CC2-15 CC6-6   WHITE   
Sondex Enable - 
I2CInit=22=80 

 CC2-16 CC6-12   WHITE   

Load Cell Cal 
Control - 
I2CInit=22=02 

 CC2-17 SDX_SKT1      Sondex 

 CC2-18 CC2-26 {CC6-1} BLACK   Enabled Line 

 CC2-19 CC2-41 CC3-41 BUSS  +5V 

 CC2-20 CC2-42 CC3-42 GREEN    GND 

 CC2-21 CC2-43 CC3-43  BUSS   -15V 
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 CC2-22 CC2-44 CC3-44 BUSS   +15V 

 CC2-23 CC2-41   BLACK   
 (+5V) TP Light 
Supply 

 CC2-24 J42-14   BLACK   
 (LP3-2+) Tool 
Power Light 

 CC2-25 TPSD-J2-4 {TPSD-J2-3} BLACK 
{ACSW3-
C-} 

Low Side Reg. 
Tool Power 

 CC2-26 CC2-18 CC6-1 BLACK   Enabled Line 

 CC2-27 J7 {J12}    (Line Input) 

 CC2-28 CC2-42   GREEN   Line To Ground 

 CC2-30 CC2-35 CC2-40 BLACK 
 {R2-2},  
{CC7-23} 

 (Line Input) 
Termination 
Resistor 

 CC2-31 R2-1 {R1-1} BLACK  (H)L1-1 Line Termination 

 CC2-33(H) CC6-18(H)      

External Power 
Enable - 
I2CInit=21=80 

 CC2-34 CC1-23   BLACK   TELA Downlink 

 CC2-35 CC2-30 R2-2 BLACK 

 {CC2-
40}, 
{CC7-23} 

 (Line Input) 
Termination 
Resistor 

 CC2-37 R1-2 (H)L1-2 BLACK   Line Termination 

 CC2-38 CC2-5   BLACK   
Tool Power to 
Sondex Relay 

 CC2-39 SDX_J1-4   BLACK   
Sondex Tool 
Power 

 CC2-40 CC2-30 CC3-12 BLACK 

 {CC2-
30}{CC2-
35}   

 CC2-41 CC2-19 CC1-19 BLACK  CC2-23 +5V 

 CC2-42 CC2-20 CC1-20 GREEN  CC2-28 GND 

 CC2-43 CC2-21 CC1-21 BUSS   -15V 

 CC2-44 CC2-22 CC1-22 BUSS   +15V 

       
 
CC3 -Line Aux  (Not Installed) 

 
   

 CC3-4 CC13-27   WHITE   
Signal Out 
(Base-4) 

 
 CC3-7 CC6-11   WHITE   I2CInit=22=04  

 CC3-8 CC6-13  WHITE  I2CInit=22=01 

 CC3-10 CC3-12 CC7-23 BLACK  Line Input 

 CC3-12 CC3-10 CC2-40 BLACK 

{CC2-
30}{CC2-
35} Line Input 

 CC3-16 CC1-16 CC6-16 WHITE  I2C Clock 

 CC3-17 CC1-17 CC6-17 WHITE   I2C Data 

 CC3-19 CC3-41 CC4-41   (B)J45-2 +5V 

 CC3-20 CC3-42 CC4-42 BUSS  GND 

 CC3-21 CC3-43 CC4-43    -15V 

 CC3-22 CC3-44 CC4-44 BUSS   +15V 

 CC3-41 CC2-19 CC3-19 BUSS   +5V 

 CC3-42 CC2-20 CC3-20 GREEN   GND 

 CC3-43 CC2-21 CC3-21 BUSS   -15V 
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 CC3-44 CC2-22 CC3-22 BUSS   +15V 

CC4 - SPARE       

       

 CC4-19 CC4-41 CC5-41 BLACK   +5V 

 CC4-20 CC4-42 CC5-42 GREEN   GND 

       

 CC4-21 CC4-43 CC5-43 BUSS   -15V 

 CC4-22 CC4-44 CC5-44 BUSS   +15V 

 CC4-41 CC3-19 CC4-19 BUSS   +5V 

 CC4-42 CC3-20 CC4-20 GREEN   GND 

 CC4-43 CC3-21 CC4-21 BUSS   -15V 

 CC4-44 CC3-22 CC4-22 BUSS   +15V 

       
CC5 – SPARE        
 CC5-19 CC5-41 CC6-41 BUSS  +5V 

 CC5-20 CC5-42 CC6-42 GREEN   GND 
 CC5-21 CC5-43  CC6-43 BUSS   -15V 

 CC5-22 CC5-44 CC6-44 BUSS   +15V 

 CC5-41 CC4-19 CC5-19 BUSS   +5V 

 CC5-42 CC4-20 CC5-20 GREEN   GND 

 CC5-43 CC4-21 CC5-21 BUSS   -15V 

 CC5-44 CC4-22 CC5-22 BUSS  +15V 

       

CC6 - PSXD       

       

 CC6-1 CC2-26 {CC2-18} BLACK   Ve Meas In+ 

 CC6-2 CC2-1   BLACK   I Meas In+ 

 CC6-5 J45-1   BLACK   

+5V Regulated 
to tool Voltage 
pots 

 CC6-6 CC2-15   WHITE   
I2CInit=22=80 
(Sondex Enable) 

 CC6-7        I2CInit=22=40 

 CC6-8        I2CInit=22=20 

 CC6-9        I2CInit=22=10 

 CC6-10        I2CInit=22=08  

 CC6-11 CC3-7   BLACK   I2CInit=22=04  

 CC6-12 CC2-16  WHITE  

I2CInit=22=02 
(LLM Relay 
Control) 

 CC6-13 CC3-8   WHITE   I2CInit=22=01  

 CC6-15 (B)J45-5      
PFC Switch 
Indicator  

 CC6-16 CC3-16 CC9-16 BUSS CC7-38 SDA - I2C Clock  
 CC6-17 CC3-17 CC7-17 WHITE   SCL - I2C Data  

 CC6-18(H) CC2-33(H)      

I2CInit=21=80 
(Halliburton 
External Pwr)  

 CC6-19 CC6-41 CC7-41 BUSS   +5V  
 CC6-20 CC6-42 CC7-42 GREEN  CC6- 4 GND  
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 CC6-21 CC6-43 CC7-43 BUSS   -15V 

       

 CC6-22 CC6-44 CC7-44 BUSS   +15V 

 CC6-24 J42-6   WHITE   VM-HI 

 CC6-25 J42-10   WHITE   CM-HI 

 CC6-26 CC13-29   WHITE   TVOLT (Base-2) 

 CC6-27 CC13-30   WHITE   TCURR (Base-1) 

 CC6-28 J42-3   WHITE    

+5V PU for 
Manual Polarity 
Control 

 CC6-29 J42-1   WHITE    
High -> POS, 
GND -> NEG 

 CC6-30 J42-2   WHITE    
Open -> AUTO, 
GND -> Pos/Neg 

 CC6-31 CC2-10   WHITE    

I2CInit=21=20 
(Polarity w/ 
Manual 
Override) 

 CC6-32 CC2-7   WHITE    
I2CInit=21=10 
(TELA Enable) 

 CC6-33 CC11-25   WHITE    

I2CInit=21=08 
(Audio Signal 
Control) 

 CC6-34         I2CInit=21=04 

 CC6-35 CC2- 9   WHITE    
I2CInit=21=02 
Low Termination  

 CC6-36         I2CInit=21=01 

 CC6-37 CC2-8 J42-18  WHITE   

I2CInit=21=40 
(Line Enable 
Control) 

 CC6-38 TPSD-J1-1    WHITE   
Voltage Control 
to TPS 

 CC6-39 J45-6    BLACK   Pos Control 

 CC6-40 J45-3    BLACK   Neg Control 

 CC6-41 CC5-19 CC6-19  BUSS   +5V 

 CC6-42 CC5-20 CC6-20 GREEN  J42-4 GND 

 CC6-43 CC5-21 CC6-21  BUSS   -15V 

 CC6-44 CC5-22 CC6-22  BUSS   +15V 

       
 
CC7 - ANASW      

 

       

 CC7-8 WHP1-D   WHITE   WHP1 Excitation 

 CC7-9 CC9-23   WHITE   Signal to CBL01 

 CC7-10 WHP1-B   WHITE   
+(4-20MA) Input 
Positive 

 CC7-11 WHP1-A   WHITE   
-(4-20MA) Input 
Negative 

 CC7-12 CC13-8   WHITE   WHP1 Signal 

 CC7-13 WHP2-B   WHITE   
+(4-20MA) Input 
Positive 

 CC7-14 WHP2-A   WHITE   
-(4-20MA) Input 
Negative 

 CC7-15 CC13-7   WHITE   WHP2 Signal 

 CC7-16 CC7-38 CC8-38 BUSS   SCL - I2C Clock 

 CC7-17 CC6-17 CC8-39 BUSS   SDA - I2C Data 

 CC7-18 WHP2-D   WHITE   WHP2 Excitation 
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 CC7-19 CC7-41 CC8-41 BUSS  J42-7 +5V 

 CC7-20 CC7-42 CC8-42 WHITE 
J42-5 WHP1-
E GND 

 CC7-21 CC7-43 CC8-43 BUSS   -15V 

 CC7-22 CC7-44 CC8-44 BUSS  +15V 

 CC7-23 CC3-10 
{R2-2}, {CC2-30}, {CC2-
35} BLACK   Line Input 

 CC7-28 CC8-5   WHITE   Signal to CCL 

 CC7-29 (B)AUX5-2      PFC Signal 

 CC7-31        Spare output 

 CC7-32 CC11-5   WHITE   Drive to Audio 

 CC7-33 CC12-3 {CC14-23} WHITE   Drive to MTT 

 CC7-38 CC6-16 CC7-16 BUSS   SDA - I2C Data 

 CC7-39 J42-15   BLACK   
Audio Speaker 
Phono Jack 

 CC7-41 CC6-19 CC7-19 BUSS   +5V 

 CC7-42 CC6-20 CC7-20 GREEN 
J42-16 
WHP2-E GND 

 CC7-43 CC6-21 CC7-21 BUSS   -15V 

 CC7-44 CC6-22 CC7-22 BUSS   +15V 

       

       

       

       

      

 

CC8 - CCLVF       

       

 CC8-5 CC7-28   WHITE   
Signal from 
ANASW 

 CC8-7 J16   WHITE   
Passive CCL 
Input 

 CC8-10        +15V 

 CC8-16 CC8-38 CC9-38 WHITE  TPSD-J1-1 SCL - I2C Clock 

 CC8-17 CC8-39 CC9-39 WHITE  TPSD-J1-2 SDA - I2C Data 

 CC8-19 CC8-41 CC9-41 BLACK  J42-11 +5V 

 CC8-20 CC8-42 CC9-42 GREEN  J42-9 GND 

 CC8-21 CC8-43 CC9-43 BUSS   -15V 

 CC8-22 CC8-44 CC9-44 BUSS   +15V 

 CC8-27 CC13-28   WHITE   
CCL Signal 
(Base-3) 

 CC8-38 CC7-16 CC8-16 BUSS   SDA - I2C Data 

 CC8-39 CC7-17 CC8-17 BUSS   SCL - I2C Clock 

  CC8-41 CC7-19 CC8-19 BUSS   +5V 

 CC8-42 CC7-20 CC8-20 WHITE  J42-13 GND 

 CC8-43 CC7-21 CC8-21 BUSS  -15V 

 CC8-44 CC7-22 CC8-22 BUSS   +15V 

       

       

      

 

CC9 - CBL1D       
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 CC9-10 CC14-8   WHITE   
Sonic Amplitude 
Signal (DSP IN1) 

 CC9-12 CC10-3 {CC14-4} WHITE   
Sync/Pulse 
Signal 

 CC9-16 CC9-38 CC13-16 BUSS  SCL 

 CC9-17 CC9-39 CC13-17 BUSS   SDA - I2C Data 

 CC9-18 CC14-7   WHITE   Threshold Signal 

 CC9-19 CC9-41 CC10-41 BUSS   +5V 

 CC9-20 CC9-42 CC10-42 BUSS   GND 

 CC9-21 CC9-43 CC10-43 BUSS   -15V 

 CC9-22 CC9-44 CC10-44 BUSS   +15V 

 CC9-23 CC7-9   WHITE   
Signal from 
ANASW 

 CC9-30 CC14-30   WHITE   
Sonic AUX (DSP 
IN9) 

 CC9-38 CC8-16 CC9-16 BUSS   SDA - I2C Data 

 CC9-39 CC8-17 CC9-17 BUSS   SCL - I2C Clock 

 CC9-41 CC8-19 CC9-19 BLACK  J42-20 +5V 

 CC9-42 CC8-20 CC9-20 GREEN  J42-19 GND 

 CC9-43 CC8-21 CC9-21 BUSS   -15V 

 CC9-44 CC8-22 CC9-22 BUSS   +15V 

       

      

 

CC10 - CBL02       

       

 CC10- 3 CC9-12 CC14-4 WHITE   Sync Signal 

 CC10-17 CC14-11   WHITE   
Neg Sync Inhibit 
(DSP DO1) 

 CC10-18 CC14-32   WHITE   
Pos Sync Inhibit 
(DSP DO0) 

 CC10-19 CC10-41 CC11-41 BUSS   +5V 

 CC10-20 CC10-42 CC11-42 BUSS   GND 

 CC10-21 CC10-43 CC11-43 BLACK PS2-S- -15V 

 CC10-22 CC10-44 CC11-44 BLACK PS3-S+ +15V 

 CC10-31        NEG Sync   

 CC10-33        POS SYNC   

 CC10-36 CC10-41   BLACK   +5V (-SYNCINH) 

 CC10-37 CC14-18   WHITE   Sync Detect 

 CC10-38 CC14-10   WHITE   
Sync Level (DSP 
DAC0) 

 CC10-39 CC14- 9   WHITE   

Threshhold 
Level (DSP 
DAC1) 

 CC10-41 CC9-19 CC10-19 BLACK CC10-36 +5V 

 CC10-42 CC9-20 CC10-20 BUSS   GND 

 CC10-43 CC9-21 CC10-21 BUSS   -15V 

 CC10-44 CC9-22 CC10-22 BUSS   +15V 
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CC11 – AUDIO 
 

     

 

 CC11-5 CC7-32   WHITE   
Signal from 
ANASW 

 CC11-6 CC14-6   WHITE   
AUDIO x 10 
(DSP IN3) 

 CC11-7 CC14-5   WHITE   
AUDIO x 1 (DSP 
IN4) 

 CC11-8 CC14-3   WHITE   
AUDIO X .1 
(DSP IN6) 

 CC11-9 CC14-2   WHITE   
AUDIO X .01 
(DSP IN7) 

 CC11-19 CC11-41 CC12-41 BLACK PS1-S+ +5V 

 CC11-20 CC11-42 CC12-42 GREEN PS2-S+ GND 

 CC11-21 CC11-43 CC12-43 BUSS   -15V 

 CC11-22 CC11-44 CC12-44 BUSS   +15V 

 CC11-25 CC6-33   WHITE   

Audio Signal 
Control 
(I2CInit=21=08) 

 CC11-41 CC10-19 CC11-19 BUSS   +5V 

 CC11-42 CC10-20 CC11-20 BUSS   GND 

 CC11-43 CC10-21 CC11-21 BUSS   -15V 

 CC11-44 CC10-22 CC11-22 BUSS   +15V 

CC12 -MTT/AUX 

 
 
      

       

 CC12-3 CC7-33 CC14-23 WHITE   Input Signal 

 CC12-18 CC13-26   WHITE   
MTT Signal 
(Base-4) 

 CC12-19 CC12-41   BUSS   +5V 

 CC12-20 CC12-42 J6-E/(H)J6-B (SHLD) BUSS   GND 

 CC12-21 CC12-43 CC13-43 BUSS   -15V 

 CC12-22 CC12-44 CC13-44 BUSS   +15V 

 CC12-41 CC11-19 CC12-19 BUSS   +5V 

 CC12-42 CC11-20 CC12-20 BUSS   GND 

 CC12-43 CC11-21 CC12-21 BUSS   -15V 
 CC12-44 CC11-22 CC12-22 BUSS   +15V 
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CC13 - USB44       

       

 CC13-1        BASE - 16 

 CC13-2 AUX4-2   WHITE   BASE- 15 

 CC13-3 AUX4-3   WHITE   BASE - 14 

 CC13-4 AUX4-4   WHITE   BASE - 13 

 CC13-5 AUX4-5   WHITE   BASE - 12 

 CC13-6 AUX4-6   WHITE   BASE - 11 

 CC13-7 CC7-15   WHITE   
BASE - 10 
(WHP2) 

 CC13-8 CC7-12   WHITE   Base - 9 (WHP1) 

 CC13-9 F2-2 {J8-D, (H)J8-J} BLACK   
Encoder Power 
to Fuse 

 CC13-10 J8-B (H)J8-B WHITE   
Encoder Phase 
B 

 CC13-11 J8-A (H)J8-A WHITE   
Encoder Phase 
A 

 CC13-12 J6-D/(H)J6-C   WHITE   
Tension 
Excitation + 

 CC13-13 CC2-13   WHITE   

Load Cell Cal 
Drive - 
I2CInit=22=02 

 CC13-14 HUB_J2-3    {Black} USB Telemetry 

 CC13-15 HUB_J2-2    (Red} USB Telemetry 

 CC13-16 CC9-16   WHITE   SCL - I2C Clock 

 CC13-17 CC9-17   WHITE   SDA - I2C Data 

 CC13-18 (H)J6-G      Cal Relay  

 CC13-19 CC13-41 CC14-41 BUSS  PS1-S+ +5V 

 CC13-20 CC13-42 CC14-42 BUSS PS1-S- GND 

   {Shield} HUB_J2-4      

 CC13-21 CC13-43 CC14-43 BUSS   -15V 

 CC13-22 CC13-44 CC14-44 BUSS   +15V 

 CC13-23        BASE-8  

 CC13-25 AUX1   WHITE   BASE-6  

 CC13-26 CC12-18   WHITE   BASE-5 (MTT) 

 CC13-27 CC3-4   WHITE   
BASE-4  
(LineAux Signal) 

 CC13-28 CC8-27   WHITE   BASE-3 (CCL) 

 CC13-29 CC6-26   WHITE   
BASE-2 
(TVOLT) 

 CC13-30 CC6-27   WHITE   
BASE-1 
(TCURR) 

 CC13-31        CTR2 

 CC13-32        CTR1 

 CC13-33          

 CC13-34 AUX4-9   WHITE   CTR4 

 CC13-35 AUX4-10   WHITE   CTR3 

 CC13-36          

 CC13-38 J6-A/(H)J6-A    (BLK) 
Line Tension 
Input Negative 

 CC13-40 J6-B/(H)J6-E    (RED) 
Line Tension 
Input Positive 

 CC13-41 CC13-19 HUB_J9-3 BLACK   +5V 

 CC13-42 CC13-20 HUB_J9-2 GREEN   GND 
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 CC13-43 CC12-21 CC13-21 BUSS   -15V 

 CC13-44 CC12-22 CC13-22 BUSS  +15V 

      

 
CC14 – DSP-AUX 
  
   

 CC14-1        
DSP IN8 (Script 
Ch7)  

 CC14-2 CC11-9   WHITE   
DSP IN7 (Script 
Ch6) Audio x .01 

 CC14-3 CC11-8   WHITE   
DSP IN6 (Script 
Ch5) Audio x .1 

 CC14-4 CC10-3 {CC9-12} WHITE   

DSP IN5 (Script 
Ch4) Sync/Pulse 
Signal 

 CC14-5 CC11-7   WHITE   
DSP IN4 (Script 
Ch3) Audio x 1 

 CC14-6 CC11-6   WHITE   
DSP IN3 (Script 
Ch2) Audio x 10 

 CC14-7 CC9-18   WHITE   

DSP IN2 (Script 
Ch1) Threshold 
Signal 

 CC14-8 CC9-10   WHITE   

DSP IN1 (Script 
Ch0) Sonic 
Amplitude 

 CC14-9 CC10-39   WHITE   DSP DAC1 

 CC14-10 CC10-38   WHITE   DSP DAC0 

 CC14-11 CC10-17   WHITE   
DSP DO1 (Neg 
Sync Inhibit) 

 CC14-12        DSP DO3  

 CC14-13        DSP DO5  

 CC14-14        DSP DO7  

 CC14-15        DSP DO9 

 CC14-16        DSP DI1 

 CC14-17        DSP DI3 

 CC14-18 CC10-37   WHITE   
DSP INT0 - Sync 
Detect 

 CC14-19 CC14-41   BLACK   +5V 

 CC14-20 CC14-42   BUSS   GND 

 CC14-21 CC14-43   BUSS   -15V 

 CC14-22 CC14-44   BUSS   +15V 

 CC14-23 CC12-3 {CC7-33} WHITE   

DSP IN16 (Script 
Ch15) Recorder 
Sig. 

 CC14-24        
DSP IN15 (Script 
Ch14) 

 CC14-25        
DSP IN14 (Script 
Ch13) 

 CC14-26        
DSP IN13 (Script 
Ch12) 

 CC14-27        
DSP IN12 (Script 
Ch11) 

 CC14-28        
DSP IN11 (Script 
Ch10) 

 CC14-29        
DSP IN10 (Script 
Ch9) 

 CC14-30 CC9-30   WHITE   
DSP IN9 (Script 
Ch8) Sonic AUX 
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 CC14-31 CC1-26   WHITE   

DSP DAC2 
(TELA Downlink 
Telemetry) 

 CC14-32 CC10-18   WHITE   
DSP DO0 (Pos 
Sync Inhibit) 

 CC14-33        DSP DO2  

 CC14-34        DSP DO4  

 CC14-35 CC1-11   WHITE   

DSP DO6 
Downlink 
Termination 

 CC14-36        DSP DO8 

 CC14-37        DSP DI0 

 CC14-38        DSP DI2 

 CC14-39        DSP DI4 

 CC14-40        DSP INT1 

 CC14-41 CC13-19 CC14-19 BUSS HUB_J9-2 +5V 

 CC14-42 CC13-20 CC14-20 BUSS HUB_J9-3 GND 

 CC14-43 CC13-21 CC14-21 BUSS   -15V 

 CC14-44 CC13-22 CC14-22 BUSS   +15V 

       

       

       

       
CC15-SDSDSP 
      
DSP J2 

      

       

 DSP_J2-1 PS1-S+   GREEN     

 DSP_J2-2 PS1-S-    BLACK     

       

       
  
DSP_J5       

       

 DSP_J5-1 HUB_J3-1     {Shield}   

 DSP_J5-2           

 DSP_J5-3 HUB_J3-2     {Red}   

 DSP_J5-4 HUB_J3-3     {Black}   

       

J41 - AC Power      

       

 J41-1 TB1-3R   BLUE {S1-1} Switched Neutral 

 J41-2          

 J41-3 TB1-5L   BLACK {S1-3} 
Switched AC 
Load 

 J41-4 JAC-1   BLUE {S1-2} AC Neutral 

 J41-5  LUG   GREEN     

 J41-6 F1-2   BLACK {S1-4} Fused AC Load 
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J42 - Voltage Meters and Controls Power     

       

 J42-1 CC6-29   WHITE   
High -> POS, 
GND -> NEG 

 J42-2 CC6-30   WHITE   
Open -> AUTO, 
GND -> Pos/Neg 

 J42-3 CC6-28   WHITE   +5V PU 

 J42-4 CC6-42 {S3-3,4,6} GREEN   
GND (TP 
Switch) 

 J42-5 CC4-20   GREEN   GND (VM-LO) 

 J42-6 CC6-24   WHITE   VM-HI 

 J42-7 CC7-19   BLACK   +5V (VM-V+) 

 J42-7 CC7-19   GREEN   +5V (VM-V+) 

 J42-8 CC4-42   GREEN     

 J42-9 CC8-20   WHITE   GND (CM-LO) 

 J42-10 CC6-25   BLACK   CM-HI 

 J42-11 CC8-19   GREEN   +5V (CM-V+) 

 J42-12 CC5-20   GREEN     

 J42-13 CC8-42   GREEN   
GND (LP3-1-) 
Enable Lamp 

 J42-14 CC2-24   BLACK   LP3-2+ 

 J42-15 CC7-39   BLACK   Audio Speaker 

 J42-16 CC7-42   GREEN   
GND (Speaker 
Gnd) 

 J42-17 ACSW3-R+   BLACK   
Tool Power 
Enable 

 J42-18 CC6-37 {CC2-8} WHITE   Safety CNTL 

 J42-19 CC9-42   GREEN   GND (LP2-1-) 

 J42-20 CC9-41   BLACK   +5V (TP Switch) 

       

J43-USB Face Plate      

       

 J43-1 HUB_J8-3  {Black}  {White} USB- 

 J43-2       {Shield} SHIELD 

 J43-3 HUB_J8-1  {Shield}  {Black} GND 

 J43-4 HUB_J8-2  {Red}  {Green} USB+ 

 J43-5           

 J43-6 HUB_J8-4  22 GA  {Red} +5V 

       

       

J45 - Voltage Control Pots      

       

 J45-1 CC6-5   BLACK   +5V Regulated 

 (B)J45-2 (B)CC4-41      +5V PFC Switch 

 J45-3 CC6-40   BLACK   Neg Control 

 J45-4 CC3-20   GREEN   
GND to Voltage 
Pots 

 J45-5 (B)C6-15   GREEN   
PFC Switch 
Indicator 

 J45-6 CC6-39   BLACK   Pos Control 

       

(B)J65 - PFC Switch      
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 (B)J65-1 (B)TPSD-J3-2     {S4-5}   

 (B)J65-2           

 (B)J65-3 (B)TPSD-J3-1    {S4-6}   

         

         

       

       

       

       

       

       

       

       

       

       

FACE PLATE ASSEMBLY      

       

P41 - AC Power      

 P41-1 S1-1 {LP1-1} {FN1-1} BLUE {TB1-3}  Switched Neutral 

 P41-2          

 P41-3 S1-3 {LP1-2} {FN1-2} BLACK {TB1-5}  
Switched AC 
Load 

 P41-4 S1-2 {JAC-1} BLUE   AC Neutral 

 P41-5 LUG   GREEN     

 P41-6 S1-4 {F1-2} BLACK   Fused AC Load 

       

S1 - AC Power Switch     
  

 S1-1 S1-1 {LP1-1} {FN1-1} BLUE {TB1-3}  Switched Neutral 

 S1-2     BLUE     

 S1-3 S1-3 {LP1-2} {FN1-2} BLACK {TB1-5}  
Switched AC 
Load 

 S1-4 S1-2 {JAC-1} BLACK   AC Neutral 

            

      
LP1 - AC Power Indicator 
      

      

 LP1-1 S1-1 FN1-1 BLACK  {P41-1}   

 LP1-2 S1-3 FN1-2 BLACK  {P41-3}   

     

 

 
FN1 - Faceplate Fan      

       

 FN1-1 P41-3 LP1-2 BLACK  {FN1-2} 
Switched AC 
Load 

 FN1-2 P41-6   BLACK   Fused AC Load 
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P42 - Voltage Meters and Controls    

       

 P42-1 S3-2 {CC6-29} WHITE   

High -> POS, 
GND -
> NEG 

 P42-2 S3-5 {CC6-30} WHITE   
Open -> AUTO, 
GND -> Pos/Neg 

 P42-3 S3-1 {CC6-28} WHITE   +5V PU 

 P42-4 S3-4 {S3-3}{S3-6} GREEN  {CC6-42} 
GND (TP 
Switch) 

 P42-5 VM-J1-4 {CC4-20} GREEN   GND (VM-LO) 

 P42-6 VM-J2-2 {CC6-24} WHITE   VM-HI 

 P42-7 VM-J1-6 {CC7-19} BLACK   +5V (VM-V+) 

 P42-8 
CC4-42 
  GREEN   

 VM-GRN-P2-4-
42 

 P42-9 CM-J1-4 {CC8-20} GREEN   GND (CM-LO) 

 P42-10 CM-J2-2 {CC6-25} WHITE   CM-HI 

 P42-11 CM-J1-6 {CC8-19} BLACK   +5V (CM-V+) 

 P42-12 

  
CC5-20 
   GREEN   

 CM-GRN-P4-
4 
 

 P42-13 LP3-1(-) {CC8-42} GREEN   
GND (LP3-1-) 
Enable Lamp 

 P42-14 LP3-2(+) {CC2-24} BLACK   
LP3-2+  Enable 
Lamp 

 P42-15 J47-1 {CC7-39} BLACK   
Audio Speaker 
Phono Jack 

 P42-16 J47-2 {CC7-42} GREEN   
GND (Speaker 
Gnd) 

 P42-17 S2-3 {ACSW3-R+} BLACK   
Tool Power 
Control 

 P42-18 S2-4 {CC6-37} WHITE   Safety CNTL 

 P42-19 LP2-1(-) {CC9-42} GREEN   

GND (LP2-1-) 
Tool Power 
Lamp 

 P42-20 S2-2 {CC9-41} BLACK   +5V (TP Switch) 

       

S2 - Tool Power Switch      

       

 S2-1 LP2-2(+)   BLUE     

 S2-2 P42-20 {CC9-41} BLACK   +5V 

 S2-3 P42-17 {ANSW3-R+} BLUE   
Tool Power 
Control 

 S2-4 P42-18 {CC6-37} BLACK     

       

LP2 - Tool Power Switch Indicator    

       

 LP2-1(-) P42-19 {CC9-41} GREEN   GND 

 LP2-2(+) S2-1   BLACK     

       

S3 - Auto / Manual Polarity Switch     

       

 S3-1 P42-3 {cc6-28} WHITE   +5 PU 

 S3-2 P42-1 {CC6-29) WHITE   
High -> POS, 
GND -> NEG 

 S3-3 S3-4 S3-6 GREEN {P42-4}  GND 
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 S3-4 S3-3 S3-6 GREEN  P42-4 GND 

 S3-5 P42-2   WHITE   
Open -> AUTO, 
GND -> Pos/Neg 

 S3-6 S3-3 S3-4 GREEN  {P42-4} GND 

       

       

VM - Panel Voltage Meter (Old Style)     

       

       

 VM-INLO P42-5   WHITE   GND (VM-LO) 

 VM-INHI P42-6   WHITE   VM-HI 

 VM-V+ P42-7   WHITE   +5V (VM-V+) 

       

CM - Panel Current Meter (Old Style)    

       

 CM-INLO P42-9   WHITE   GND (CM-LO) 

 CM-INHI P42-10   WHITE   CM-HI 

 CM-V+ P42-11   WHITE   +5V (CM-V+) 

       

VM - Panel Voltage Meter (Red Segment Style)     

       

 VM-J1-4 P42-8  GREEN   GND (VM-LO) 

 VM-J1-6 P42-7   BLACK   +5V (VM-V+) 

 VM-J2-1 P42-5  GREEN   VM-LO 

 VM-J2-2 P42-6   WHITE   VM-HI 

 VM-J2-5 VM-J2-6      Ref Out 

 VM-J2-6 VM-J2-5      Ref In 

       

CM - Panel Current Meter (Red Segment Style)    

       

 CM-J4-4 P42-12  GREEN   GND (CM-LO) 

 CM-J4-6 P42-11   BLACK   +5V (CM-V+) 

 CM-J3-1 P42-9  GREEN   CM-LO 

 CM-J3-2 P42-10   WHITE   CM-HI 

 CM-J3-5 CM-J2-6      Ref Out 

 CM-J3-6 CM-J2-5       Ref In 

       
LP3- Line Enable Lamp 
     

       

 LP3-1(-) P42-13 {CC8-42} GREEN   GND (LP3-1-) 

 LP3-2(+) P42-14 {CC2-24} BLACK   LP3-2+ 

       

J47 - Audio Jack    

       

 J47-1 P42-15 {CC7-39} BLACK   Audio Speaker 

 J47-2 P42-16 {CC7-42} GREEN   
GND (Speaker 
Gnd) 
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P43-USB Faceplate Connector {OLD}   

       

 P43-1 J48-WHT       USB- 

 P43-2 J48-GRY       SHIELD 

 P43-3 J48-BLK       GND 

 P43-4 J48-GRN       USB+ 

 P43-5           

 P43-6 J48-RED       +5V 

       

P45 - Voltage Control Pots    

       

 P45-1 R4-3 {R5-3}{CC6-5} BLACK   +5V Regulated 

 (B)P45-2 (B)S4-2 {CC4-41} WHITE   +5V 

 P45-3 R4-2 {CC6-40} BLACK   Negative Control 

 P45-4 R4-1 {R5-1}{CC3-20} GREEN   GND 

 P45-5 S4-1 {(B)CC6-15} GREEN   PFC Switch 

 P45-6 R5-2 {CC6-39} BLACK   Positive Control 

       

R4- Negative Voltage Adjust    

       

 R4-1 R5-1 P45-4 GREEN  {CC3-20} GND 

 R4-2 P45-3 {CC6-40} BLACK   Negative Control 

 R4-3 R5-3 P45-1 BLACK  {CC6-5} +5V Regulated 

       

       

R5- Positive Voltage Adjust    

       

 R5-1 R4-1 {P45-4}{CC3-20} GREEN   GND 

 R5-2 P45-6 {CC6-39} BLACK   Positive Control 

 R5-3 R4-3 {P45-1}{CC6-5} BLACK   +5V Regulated 

       

(B)P65 - PFC Switch    

       

 (B)P65-1 (B)S4-5 (B)TPSD-J3-2       

 (B)P65-2           

 (B)P65-3 (B)S4-6 (B)TPSD-J3-1       

       

(B)S4 - PFC Switch     

       

 (B)S4-1 (B)P45-5 {(B)CC6-15}       

 (B)S4-2 (B)P45-2 {CC4-41}       

 (B)S4-3           

 (B)S4-4           

 (B)S4-5 (B)P65-1 {(B)TPSD-J3-2}       

 (B)S4-6 (B)P65-3 {(B)TPSD-J3-1}       
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21 Checks-Out Procedure 
A. Panel Information 
 
Company:  ____________________ Checked By: ___________________   
Panel Type: ________ Serial#: _________________ Key#:____________ 
Date: ____/___/_____Key Code#:  ________________________________ 

A. Record version of all boards installed – “X” indicates not installed 
 Panel must be “OFF” – No power on – before removing or installing any 

boards, during this procedure. 
 Acquisition should be closed, every time that it calls for “Turning Panel 

OFF”  
 Attach P - Touch Card Slot Identification Tape, plotter label, and panel type 

labels. 
 Remove all boards from the Card Cage located inside the Interface Panel 

 
BOARD VER. BOARD VER. BOARD VER. 
USBHUB  TPSD   DSPAUX  
SDSDSP  USB44  PSXD  
PRELAYS  ANASW  CCL  
CB1D  CBL02  AUDIO  
AFP  MTT  TELA  
      
      

 
 
 
 
 
 
 

 
Section 
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TPSD, USBHUB are permanent boards located at the rear of the panel 
 
  BOARDS FROM LEFT TO RIGHT 
  CC1-  TELA 
  CC2-   PRELAYS 
  CC3-  FREEPOINT 
  CC4-  SPARE 
  CC5-  SPARE 
  CC6-  PSXD 
  CC7-  ANASW  
  CC8-  CCL 
  CC9-  CBL1D 
  CC10-  CBL02 
  CC11-   AUDIO 
  CC12-   MTT 
  CC13-  USB44 
  CC14-   DSPAUX 
  CC15-  DSP 
 
        
 
 

 
 

B. Check Power Supplies voltages on card connectors 
 +15 Volts @ pin 22 - 44 

-15 Volts  @ pin 21- 43  
 Ground  @ pin 20- 42 

                         + 5 Volts  @ pin 19- 41  
 
C. Sondex Ultralink Board Pre-Wiring 
 

(OPEN BACK PLATE OF THE PANEL TO DO THE FOLLOWING) 
Verify the following connections: 
 
Connector SDXJ1 Wiring (4 pin connector) 

J1-1   to CC2-39. 
J1-4   to TB1-1 

 
Connector SKT1 Wiring 

SKT1 (Coaxial cable) center conductor to CC2-17. 
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Connector SDX J12 Wiring (5 pin connector) 
J12-3 (AWG 22) connect to TPSD-J5-4 (+5 VDC) 
J12-4 (AWG 22) connect to TPSD-J5-3 (GND) 
J12-1 (AWG 22) connect to TPSD-J5-2 (-15VDC) 
J12-5 (AWG 22) connect to TPSD-J5-1 (+15 VDC) 

 
Connector SDXJ5 Wiring (5 pin connector) 

J5-5 (White AWG 22) connect to HUB-J9-4  
J5-3 (Red AWG 22) connect to HUB-J9-3      

 J5-2 (Black AWG 22) connect to HUB-J49-2 
   
  
D. USBHUB-R13 Pre-Check and USBHUB 

 
Close All in acquisition software and Turn Interface Power “OFF” 

 
All USB44-R7 – before installing, check for the following.  

J2 – Place jumper pin on 1-3 (right side) 
Make sure C26 is NOT installed (near U4)  
Jumper Near to C23 and C24 

 Standard USB44-R7 – before installing, check for the following. 
IC14 = Pin 1-3 shorted  
R12 = shorted 
R14 = 24.9 ohms 
R19 = 5.6 Kohms 
C25 = Not Installed 
C29 = Not Installed 
K1 = Not Installed 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 

Halliburton USB44-R7 – before installing, check for the following. 
IC14 = LM78L12 Installed 
R12 = 3.9 Ohm Installed 
R14 = Not Installed 
R19 = 249 Ohm Installed 
C25 = .01 UF Installed 
C29 = .33 UF Installed 
K1 = Installed 
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Make sure Interface is “OFF” – No Power 
  
 Install USB44 board 

 Install DSPAUX and SDSDSP boards.  DSPAUX- should be on an extender 
board with an extender ribbon to the DSP board.  
Check polarity of Power Connectors to DSP board J2. 
Looking at component side of the board,  left pin is ground and right pin is 
+5VDC. 
On DSP board the two white wires of J2 should go up towards the top of the 
board. On J5 white wire is ground.  

 
With Interface Panel Power “OFF” 
 Open Windows Device manager, Click on Universal Serial Bus controllers 
 Connect USB cable from computer to front of panel 
  Two new Generic USB Hubs should appear 
  Safenet Inc. Hardlock Key should appear 
 Connect USB Device to “Printer” USB port of Hub on rear of panel 
  That Device should appear 
 
Turn Interface Panel Power “ON” 
  Scientific Data Systems CyStdFX1 Device should appear 
  Scientific Data Systems LOGFX-DSP Device should appear 
   Check remaining 4 USB Port to a response of a USB device 
Turn Interface Panel Power “OFF” 

Connect USB cable from computer to rear of panel  
Turn Interface Panel Power “ON” – Recheck all of the above devices 
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Fig. D.1 Universal Serial Bus Controllers 
 

 
 
E. USB44 Checks 

Standard Panel - Check for +15VDC at Pin “D” of tension connector. Check for +5VDC 
at Pin “D” of encoder connector. 

 
 
 

 
 

Put Sample DC Voltage on J9 (Rear Panel BNC-labeled AUX-1). Start Acquisition and 
verify Base-6 response by clicking   “Monitor”-> Devices - Base-6 = Sample DC Voltage +/-0.2 

 

 
Fig. E.1 DAMUPCI 

Connect Simulator Box and start Simulator Program. Set Simulator Tension to Low.  
Open Acquisition. Click on “Action -> Calibrate -> Surface Line Tension”. Set calibration 
values to 0 and 10000. Check that depth responds to Speed and Direction controls. 

 

Halliburton Panel –  
 Check for +12V DC at pin “C’ of tension connector. 
 Check for +5V DC ad pin “J’ of the encoder connector 
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Sample the Low Reference.  

Fig. E.2 Surface Tension Calibration 
 

Click [Begin] to start sampling. When 10 second sampling is complete, click [Accept] to 
accept the sample 

 
In the Simulator window, Set the tension to High. From the calibration window, sample 

the high reference. 
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Fig. E.3 Surface Tension Calibration 

 
 The calibrations should have a gain in the order of 2500 with a negative offset of the 
same magnitude. If valid, click on [Accept] to finish the calibration. 
 
 
 
 
 
 
 
 
 
 
AUX4 - Auxiliary Input Connector 
 From Acquisition click on Monitor ->Devices -> Base and check the following 
table for high and low inputs from the test box   
 
       

Channel LOW Switch  HIGH Switch  

Base-11 0.57  3.63  

Base -12 0.73  1.73  

Base -13 0.98  0.000  

Base -14 1.31  -1.71  

Base -15 1.78  -3.63  

 
 

Baker Tension 
 Turn Panel “OFF”. Pull USB44 board and remove R19 and R14 so board 
accepts + 5 Volt tension input. Re-install board and turn panel “ON”. 
 Connect Baker Line Tension Check connector to tension input. From 
Acquisition, click on Monitor -> Sensors. Check that the LTEN sensor reads 1.4 V. 
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Fig. E.4 CYSTD Low Values 
 

 
Connect function generator to test points on test box, with 5 volt square wave @ 1 KHz 
Note response on Base-33 and Base-34  CTR3 / CTR4. 
Set the switch in HI  
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Fig. E.5 CYSTD Low Values 
 
 Close All in acquisition software and Turn Interface Power “OFF” 
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Halliburton Tension Test 
 
Select Utilities -> Edit Logging Service Details 
Select the NONE Service 
Click on “Add -> Control. 
Scroll down the dropdown Control key word list and select LTCALHI. 
Click [OK] and save the service. 

 
Start Acquisition in the None Service 
Select “Action -> Calibrate -> Surface Line Tension” 
Set Low Reference Point = 0 
Set High Reference Point = 3200 
Click on [<<Sample] for the Tension at Low Reference 
Expected value should be 1.9 + 0.1 
Select [Begin] 
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Fig. E.6 Halliburton Surface Tension Calibration 
  

 
If the reading is in tolerance, click [Accept]. 
Click on [<<Sample] for the Tension at High Reference. 
Click on [Begin] 
Expected value should be .22 + 0.1. 
If the value is within tolerance, click [Accept]. 

 
 
Typical calibration value should be as follows: 
 Gain = -1860 + 50 
 Offset = 3600 + 100 
If the calibration is within tolerance, click the [Accept] to save the calibration 

 
 
From Acquisition, select “File-> Close All” and turn the interface power OFF. 
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F. DSPAUX and SDSDSP Checks 
Install DSPAUX board on extender card and connect with the DSP 

Board through extension cable 
 Turn Interface Power “ON” – Start Acquisition 

    Select Gamma CCL Service – Do not enable the line. 
At PMON window, Click on the – Show Axis Icon 
Click on the Enlarge Icon until scales are as shown below 
Adjust P1 on DSPAUX board to adjust the baseline to 0 volts 

 
   

   
Fig. F.1 DSPAUX Adjustment  
 

Close All in acquisition software and Turn Interface Power “OFF” 
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G. PSXD-R2 or PSXD-R7 - PRELAYS-R5 – TPSD-R6  
 

Check PSXD.R2, C16 and C17 should be .047 uF 
 
 

 Check for Jumper on CC3 between Pins 10 and 12. If no jumper, install FreePoint Board 
Install PSXD board on CC6 slot. Install PRELAYS board on extender card in CC2 slot. 

 Set tool voltage Polarity to Auto – Turn Interface “ON” 
  

Open Acquisition to the  “None “ Service 
Edit-Calibrations – Set TVOLT and TCURR gains to 1.0 and Offset =0 
 
Open “Utilities” -> “Edit Logging Service Details” 
 Click on the “None” Service 
 Check that Line Termination Control is set to “High” and Save 

Fig. G.1 Line Termination Control 
 
 
 
 
 
 
 
 

  

For Halliburton panels, check R8 being 200k ohm 
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On PRELAYS board measure 300 ohms between pin 5 and pin 26.  
 
 
 
 
 
 
 

Edit “Controls” set Line Termination to “Low”  – SAVE 
Reload “None Service”  

 
On PRELAYS board measure 150 ohms between pin 5 and pin 26 

 
 
 

Edit “Controls” set Line Termination to “High” – SAVE 
Reload “None Service” 
On PRELAYS board measure 300 ohms between pin 5 and pin 26.  

 
 
 

Close All in acquisition software and Turn Interface Power “OFF” 
Place PRELAYS board in CC2 slot 

 
G 1. PSXD-R2 - PRELAYS-R5 – TPSD-R9 

Turn Interface “ON” 
Reload “None Service” 
Click on “Action -> Power Control”. Click on “Keep this box” to keep window open. 
Enable the line (Tool Voltage Polarity Switch should be in “Auto”) 
Measure the voltage across TPSD TP1 and TP2, Adjust P2 to .80 V DC 
Set Software control to 0% - Adjust P6 on PSXD for 0.0 V at TPI on PSXD 
Set Software control to 100% - Adjust P5 on PSXD for 8.0 VDC at TPI.  
Adjust P3 on PSXD for 0.0 VDC on front panel voltage meter  
Adjust P4 on PSAUX for 0.0 milliamps on front panel current meter 
Adjust software control to 25% 
Turn “ON” Tool Power Switch – with no load 
Adjust P1 on TPSD.R1 board back panel for 100 VDC at line input connector 
Adjust P2 on PSAUX board for 100 VDC at front panel voltage meter 
Switch polarity to “POS” position; verify positive voltage control with knob 
Switch polarity to “NEG” position; verify negative voltage control with knob 
Turn Tool Power “OFF” 
Switch Polarity to “AUTO” 
Attach 1k-load box to line input 
Turn Tool Power “ON” 
Adjust Software control for 100 VDC at front panel voltage meter Close to 30.0% 
Adjust P1 on PSXD board for 100 milliamps at front panel current meter 

Halliburton panels should read 150 Ohms 

Halliburton panels should read 1.9 Ohms. 

Halliburton panels should read 150 Ohms 
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Edit Calibrations TVOLT / TCURR. Set Gain =1 and Offset =0 
Set Software control to 100% 
Verify Maximum voltage of approximately 275 VDC @ 275 ma to 300VDC @ 300 ma 
Set Software control to 0%, disconnect load box   
Attached 100 ohms load resistor to input line 
Set Software control to 100% for approximately 48 V DC @ 480 mas Max. 
Check both polarities (Positive and Negative) 
Adjust Software control for 40Vdc @ 400 ma at front panel voltage meter  
Check both polarities (Positive and Negative). 
Set Software control 0% and Switch polarity to “POS” position 
Set positive voltage with knob close to 3.3 for 40Vdc @ 400 ma leave test one hour. 
Switch polarity to “NEG” position. 
Set negative voltage with knob close to 3.3 for -40Vdc @ -400 ma leave test one hour. 

Calibrate tool voltage and current (if computer is to be shipped with system) 

Close All in acquisition software and Turn Interface Power “OFF” 
 
 
 
 
G 2. PSXD-R7 and TPSD-R9 
 
Start acquisition and start the PSXD PSAUX setup service. Place tool Polarity switch in AUTO. 
 Click on “Action  -> Power Control”,  Click check “Keep this box open” 
 “Click  -> Open Configuration” and set all values to 400 and ramp time to .3 then click 
[Apply]. 
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Fig. G2.1 Power Control Configuration 
 

 Set Software control to 0% 
Enable line but do not turn on Tool Power Switch 

 On TPSD R9.1 adjust P2 to .80vdc between TP1 and TP2 
 Adjust VZero Slider for 000 volts on the front panel 
 Adjust IZero Slider for 000 ma on the front panel 
 Adjust VZeroBias Slider for 0.000vdc on PSXD TP3  (+  -002V) 
 Adjust Software control for 100vdc and check PSXD TP3 for 2.00vdc (+.01vdc) 
 Turn on the Tool Power switch and adjust P1 on TPSD board for 100vdc on the rear 
panel line connector. 
 Adjust VSetPoint Slider for 100v on the front panel 
 Switch Polarity switch to POS and verify POS voltage control 
 Switch Polarity switch to NEG and verify NEG voltage control 
 Return Polarity switch to Auto and connect 1Kohm load. 
 Adjust software for 100vdc on the front panel meter and adjust ISetPoint slider for 100ma 
on front panel. 
 From Acquisition Click on Edit -> Device Configuration -> SDSTIP 
 Click on [Save Settings] to save current PSXD settings to the EPROM on the PSXD 
board. 

 
 Click on the red Windows Close button to close the PSAux Setup window.  
 Calibrate the Voltage and current at 0vdc at 0ma and 100vdc at 100ma. ** This step is 
important since these values are stored on the EPROM of the PSXD board and are used when a 
service is loaded. ** 
 Verify that the gains for TVOLT and TCURR are approximately 100 and the offsets are 
approximately 0 
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Fig. G2.2 Power Calabration 
  
 

Check for voltage and current max near 250 volts @ 250 ma. 
 Attach a 100ohm load and verify a current limit of near 400ma. 
 Set software controls to 0 Volts and switch polarity to “POS” position 
 Set positive voltage with knob close to 3.3 for 40 VDC @ 400 ma and test for 1 hour 
 Monitor Sensors – Check that TVOLT=.4 and TCURR=4.0 
 
 
 Baker Hughes Panel Check - TPSD PFC Current Limit 

 
Normal operation of the panel is with the PFC Current Limit Switch in the up 
position. With the switch in the down position, Check that the PFC Current Limit 
light comes on. Attach a 1k Ohm dummy load to line input of the panel. Enable line 
and check for current limit at 100 ma (+ 5 ma) 
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H. ANASW-R17  
Open Utilities -> Edit Logging Service Details 
Click on the “None” Service. Check that the SDSTIP device has SPKRVOL enabled. 

 
Fig. H.1 Service Editor 

 
Click on Add -> Control. Select HWFilter=Off. Click [OK] 
 

 
 
 
Fig. H.2 Service Editor Add Control 
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Save the service. 
Turn Interface “ON”, and Tool Power “OFF” 
 Load the “None” Service. Click on Action -> Power Control -> Enable 
Attach function generator to line-input 
Apply 1 kHz, 1V peak to peak at ANASW-TP-1 
Check 1Vpp @ 1 KHz at TP1and TP2 
Check Audio Speaker output and Speaker Volume slider control. 
In the Service Editor, Change the HWFilter=ON or High 
Save the edited service and restart the “None” service in Acquisition 
Apply 1 kHz, 1V peak to peak at ANASW-TP-1 
Place the oscilloscope test lead on test point 2 and reduce the frequency until you reach 
.5V p-p, the frequency should be about 375 Hz 
 Repeat test while setting HWFilter to Med and Low. 
The .5V p-p point should be 250Hz and 100Hz respectively. 
With the HWFilter in either On, High, Med or Low confirm that the Active CCL works.  
In the Service Editor, Change the HWFilter=OFF 
Save the edited service. 
 

Well Head Pressure Checks 
 Attach Simulator Box Tension connector to WHP1 connector. From Acquisition click on 
Monitor -> Devices -> Base. Check that BASE-9 reads ~1.0 V at low tension setting and ~5.0 V 
at high tension setting. 
 Move the tension connector to WHP2 connector. Check that Base-10 reads ~1.0 V at low 
tension setting and ~5.0 V at high tension setting. 
 

From Acquisition, Click on File -> Close All 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Baker Hughes Panel Checks – Panel Type CBHA 
 
AUX5 Inputs 
Connect DB-9 Connector to AUX5 Input and connect to simulator box. 
 (Pin 2 is signal and Pin 3 is Ground or shield) 
 
Using the Service Editor, Copy the Temperature Log (Neg Temp Pulse) service 
and rename to Baker Test. 
 
Click on Add -> Control. Select Control Key Word “PFCInput” with the value “Yes” 
 
Start the simulator and load “Gamma Ray – Temp – CCL.sim” 
 
Start a log pass and note response of Gamma, Temp, and CCL 
 
 



 

204 
 

 
 
 
 
I. CCLVF-R2 CHECKLIST 

Install CCL board 
Turn Interface “ON” and TOOL POWER OFF 
Attach function generator to line in 
Start Acquisition and Load CCL Service –“Collars” 
Select -> Action -.Power Control ->Enable 
Adjust function generator to apply 2 Hz, 1 volt peak to peak signal at ANASW-TP-1 
Set CCL slider to maximum. Edit calibration set Gain =1 and Offset =0 
Start a log pass with scales set from –10 to 10 
Check for CCL Gain slider bar control 
Check for cut-off frequency of 10 Hz 

 

 
Fig. I.1 Sample Log Collars Service 

 
Disable line and connect the function generator to the Passive CCL input 
Go to Utilities -> Edit Logging service details 
Check that the “Shooting Collars” service has the following Controls 
 CCLInput=Passive 
 CCLFilterFq=10 
Start Acquisition and load “Shooting Collars” service 
Start a log pass with scales set from –10 to 10 
Check the signal should be –9 to 9 on the Log 
Check that the CCL Gain slider responds 
Check for frequency cut off starting at 10 Hz 
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             Fig. I.2 Sample Log Shooting Collars Service 
 
 
 Close All in acquisition software and Turn Interface Power “OFF” 
 
 
 
      
 
Ji. CBL1 R6 and CBL02 

On CBL02_14 check J2 jumper should be on top (1-2) 
Install both CBL boards – CBL1D-R6 and CBL02-14 
Attach function generator to line 
Load CBL1-Test service and enable the line 
Apply 1 KHz 0.5vpp sine wave to ANASW TP1 
Set Panel Controls and SDS TIP as follows: 

Click Edit -> Device Configuration -> SDSTIP 
For each of Sonic, Sync, and Aux – Set Gain, Q, Fc, and Highpass as shown 
Set all Gain slider bars to maximum at 255 

 
 

 



 

206 
 

 
Fig. Ji.1 CBL1-Test Service 1Khz .5Vpp 
 

Set the Panel Controls to 125 and verify that the signal size decreases to one half as shown in the 
following 
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Fig. Ji.2 CBL1-Test Service 1Khz .5Vpp 50% Panel Control 
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Set the Panel Controls to 25 and verify the following 
 
 

 
Fig. Ji.3 CBL1-Test Service 1Khz .5Vpp 25% Panel Control 
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Change the input frequency to 2 KHz, Set the Panel Controls to Max, and verify the following: 
 

 
 
Fig. Ji.4 CBL1-Test Service 2Khz .5Vpp 
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Change the input frequency to 500 Hz, and verify the following; 
 

 
Fig. Ji.5 CBL1-Test Service 500hz .5Vpp 
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Change the input frequency to 1 KHz, Set the SDS TIP, and verify the following: 
 

 
Fig. Ji.6 CBL1-Test Service 1Khz .5Vpp band Pass 
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Change the input frequency to 2 KHz, and verify the following: 
 

 
Fig. Ji.7 CBL1-Test Service 2Khz .5Vpp band Pass 
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Set the SDS TIP Panel and verify the following: 
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Change the input frequency to 200 Hz, and verify the following: 

 
 
 
Fig. Ji.8 CBL1-Test Service 200 hz .5Vpp Band Pass 
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Change the input frequency to 15 KHz, Set the SDSTIP Panel, and verify the following:  
 
 

 
Fig. Ji.9 CBL1-Test Service 15 khz .5Vpp  
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Change the input frequency to 20 KHz 
 

 
Fig. Ji.10 CBL1-Test Service 20 khz .5Vpp  
 
 
 
 
 
 
Change the input frequency to 5 KHz 
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Fig. Ji.11 CBL1-Test Service 5 khz .5Vpp  
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Change the input frequency to 15 KHz, set the SDS TIP, and verify the following: 
 
 

 
 
Fig. Ji.12 CBL1-Test Service 15 khz .5Vpp Band Pass 
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Change the input frequency to 30 KHz, and verify the following: 
 

 
Fig. Ji.13 CBL1-Test Service 30 khz .5Vpp Band Pass 
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Change input frequency to 5 KHz, and verify the following: 
 

 
Fig. Ji.14 CBL1-Test Service 5 khz .5Vpp Band Pass 
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Change the input Frequency to 1 KHz, set the SDS TIP, and verify the following: 
 
 

 
Fig. Ji.15 CBL1-Test Service 1Khz .5Vpp 
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Set the SDSTIP Panel, and verify the Following: 
 
 

 
Fig. Ji.16 CBL1-Test Service 1Khz .5Vpp Pre Filter Setting 8 
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Jii. CBL1 R13 and CBL02 

 
 
 
On CBL02_14 check J2 jumper should be on top (1-2) 
Install both CBL boards – CBL1D-R13 and CBL02-14 
Attach function generator to line 
Load “CBL1 Test1”- service and enable the line 
Apply 1 KHz 500mv pp sine wave measured at the ANASW TP1 
Set Panel Controls and SDS TIP as follows: 

Click Edit -> Device Configuration -> SDSTIP 
For each of Sonic and Sync – Set Gain, Q, Fc, and High Pass as shown 
Set all Gain slider bars to maximum at 255 
 

 
Fig. Jii.1 CBL1 Test1 Service 1Khz 500mv pp 
 

 

 



 

224 
 

Start a time Recording. 
Slowly reduce the Sync Gain slider to 0 and back up to 255 verify the output. 
  
 

 
Fig Jii.2 Sync Slider 
 
Slowly reduce the Sonic Gain Slider to 0 and back up to 255 verify output. 
 
 

 
Fig Jii.3 Sonic Gain Slider 
 
On the SDS Tool Interface window put a check in the Sonic Pre-Filter Check box and then uncheck. 
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Fig Jii.4 Sonic Pre Filter Radio Button 
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Adjust the frequency output from 200 Hz to 2k Hz and then return to 1k Hz. 
 

 
Fig Jii.5 200-2k Hz frequency sweep  Q=1  High Pass 
 
Change to the Band Pass radio button and adjust the frequency output from 200 Hz to 2k Hz and then 
return to 1k Hz. 
 

 
 
Fig Jii.6 200-2k Hz frequency sweep Q=1 Band Pass 
 
Change the Radio buttons back to High pass and change the Q to 2.00. Once again slowly change the 
frequency from 2—to 2k hz and back to 1k hz. 
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Fig Jii.7 200-2k Hz frequency sweep   Q=2 High Pass 
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Change the Radio buttons to Band pass. Once again slowly change the frequency from 2—to 2k hz and 
back to 1k hz. 
 

 
 
Fig Jii.8 200-2k Hz frequency sweep   Q=2 Band  Pass 
 
 
Apply 15k Hz and adjust the Fc to 15000 for both Sonic and Sync inputs. Slowly sweep to 5k Hz to 20k 
Hz and back to 15k Hz. 
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Fig Jii.9 5k -20k Hz frequency sweep   Q=2 High Pass 
 
 
Change to Band pass and slowly sweep to 500 Hz to 20k Hz and back to 15k Hz. 

 

 
 
Fig Jii.10 5k -20k Hz frequency sweep   Q=2 Band Pass 
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Return the SDS Tool Interface Panel Configuration to its original state. 
 
 

 
Fig Jii.11 Default settings 
 
 
 
 
 
 
 
All Time recordings may be done as one complete log, separate passes were used for demonstration 
purposes. 
 
 
 
 
. 
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. 

CBL1 R13 Aux Chanel test 
 
Close the CB1 Test1 service and open the CBL1 Test2 Service. 
Enable the wireline and adjust the signal at the ANASW TP1 for 200mv @ 20k Hz 
 
Put a check in all three Stage radio buttons, Start a Time log and slowly move the slider from max to min 
and back to max. 
 

 

 
 
Fig Jii.12 Slider Sweep 
 
 
 
Start a time drive and sweep the frequency input from 2kHz to 100kHz. 
The output should resemble the log below. 
 



 

232 
 

 
 
 
 
Fig Jii.13 Frequency Sweep 2 kHz -100 kHz 
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Start a time log and enable the Stage radio buttons in sequence to cover all 8 options remembering to 
Apply between each change 

 
 
 
Stage  1 Stage 2  Stage 3 
 
X  X  X 
Y  X  X  
X  Y  X 
Y  Y  X 
X  X  Y 
Y  X  Y 
Y  Y  Y 
 

Fig Jii.14 Stage settings  
 
Your output should resemble the Log. 

 
Fig Jii.15 Stage settings changed @ 20k Hz 50mv pp  
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K. SIE 1x1 and CSSM 3 1/8 Bond 
Load SIE1x1 service from simulator box 
Select the “SIE cement Bond 1x1”, and Enable the Line 
Start Simulator 
Check travel time- check invert of signals with tool editor 

 

Set the panel control and SDS Tool Interface Panel 
Record at least 200 ft of a log pass 

 
Fig. K.1 SIE 1x1 Bond Signal 
 

Select service CSSM 3 1/8 RBT medium to long lines 
Open the simulator program and load the tool css25.sim 
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Fig. K.2 Load CSS Sim 
 

 
Enable the line, and Start Simulator 
Adjust Pulse Monitor PMON, and Set the panel control and SDS Tool Interface Panel 
Set the following values simulator at - 45 ft/m, depth 8000 ft and record up for at least 4 hours. 
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Fig. k.3 CSS Bond Signal 

 
 
Check for readings on CCL – Travel time –Err count – Gamma ray 
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On - Monitor – Devices – SDSDSP 

 
 

 
Fig. K.4 CSS Log and DSP Signals 
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L. AUDIO 
Adjust P6 so that output of U9 is + 7.5 volts D.C. 
Adjust P5 so that output of U8 is –7.5 volts D.C. 
With the power supply disabled adjust P8 for zero offset on TP4 
With signal generator connected to “Line in” at 1 kHz, apply voltage to read 10 volts 

Peak-to-peak at pin 5  
Select the NOISE LOG service and Enable the Line 
On the Audio board, Place scope probe at TP1 and adjust P1 for 2.5 volts peak to 

peak 
Ground input (at Line in) and adjust P8 for zero offset at TP4. Check offsets at TP2 

and TP3 
Adjust signal generator so that signal at TP1 is 0.500 volts peak-to-peak 
Place scope at TP2 and adjust P2 for 5 volts peak-to-peak output 
Adjust signal generator so that signal at TP2 is 0.500 volts peak-to-peak 
Place scope probe at TP3 and adjust P3 for 5 volts peak-to-peak output 
Adjust signal generator so that signal at TP3 is 0.500 volts peak-to-peak 
Place scope at TP4 and adjust P4 for 5 volts peak-to-peak output 
Select [Start Sampling} 

 
Fig. L.1 .5vpp 1 khz @ TP3  
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Set Generator 6 KHz 

 

 

 

Fig. L.2 .5vpp 6 khz @ TP3  
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Set Generator 1 KHz @ 250 mv peak-to-peak at Pin 5 the Audio Board 

 
Fig. L.3 1 KHz @ 250 mvpp at Pin 5 the Audio Board 
 

Set Generator 1 KHz @ 1.5V peak-to-peak at Pin 5 the Audio Board 

 
Fig. L.4 1 KHz @ 1.5 vpp at Pin 5 the Audio Board 
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Set Generator 1 KHz @ 10V peak-to-peak at Pin 5 the Audio Board 
 

 
Fig. L.4 1 KHz @ 10vpp at Pin 5 the Audio Board 
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Set Generator 10 KHz @ 10V peak-to-peak at Pin 5 the Audio Board 

 
Fig. L.4 10 KHz @ 10vpp at Pin 5 the Audio Board 

 

 Apply 1 kHz, .5V peak to peak at ANASW-TP-1 
Check 12V peak to peak at TP-3 
Connect the speaker to Audio out 
 Increase and decrease the volume with the slider speaker control 
 
M. APPLIED FREEPOINT  

Setup Freepoint tool to run through the shop line 
Tool Power Switch Must be ON 
Select Service /Freepoint Applied 
Select [Setup] 
Set in Raw reading = 10 
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Fig. M.1 Freepoint 
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Click [Set Tool] 

 
 

Fig. M.2 Freepoint Adjustment 
 

 
Make sure that the Set Power is reaching the tool 
After setting the tool Adjust P1 so that the gauge indicator zeros in the middle 
Select [Set Tool] once more and check that gauge returns to previous position. 
 
Click [Start Log] and record a pass. While recording adjust the torque o the tool to 

indicate change as shown. 
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Fig. M.3 Freepoint Log 
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N. TELA  
 
 

Check the Capacitor C24 has been replaced by a jumper. 
Check the jumper on K1 (12-14) and Install the TELA board.  
      
   
Turn Interface “ON”, Power Control Enable, and TOOL POWER “OFF” 
Load TELA-TEST USB PANEL Service, and Enable line 
Check the Signal in TP7 (IN) 
 
 

 
 
Fig. N.1 TELA Signal 

 
Check the Signal in TP6 (OUT) and @ LINE connector on Rear of the Panel  
 



 

247 
 

 
 

Fig. N.2 TELA Signal 
 
 
O. MTT   
 
 

Select Computalog MTT/Caliper 
Action/Power Control/Enable 
Load simulator mttair.sim 
Select MTT / Caliper service, enable line power and adjust discriminators. 
Place scope probe at TP2 and adjust P1 to 3.5 Volts Peak to Peak 
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Fig. O.1 MTT Signal 3.5 Vpp 
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Adjust P3 for 0.0 volt offset at TP4. Monitor the output window for MTT as close 
to 0 inch and 0 volt on sensor window. 
 

 
Fig. O.2 MTT Calibration  
 

Calibrate MTT. Enter 0 inch for low reference point, click sample, begin, and 
accept buttons to finish the first part of calibration process. 
Load simulator mtt55.sim, and Start simulator 
Adjust P2 until 1.85 Volts is read at sensor window or 1.85 inches at sensor 

window. 
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Fig. O.3 MTT Sensor and Output readings 
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Fig. O.4 MTT Calibrations 
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Calibrate MTT. Enter 1.85 in for high reference point. Click sample, begin, and 
accept buttons to finish the calibration process 

 
 
At this point the MTT should read as 1.85 volts on sensor window and 1.85 
inches on monitor window 
 

 
 
 
Fig. O.5 Calibrated MTT Values 

 
 
 
 

 
 

 



 

254 
 

Select simulator and Load simulator mttair.sim At this point the MTT should read 
as 0 volt on sensor window and 0 inch on monitor window. 
 
 

 
Fig. O.6 MTT Zero Calibration Check 
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P. Recorder Service 
Select the Recorder service.  
Set the Attenuation to 0 %. 
Attach function generator to line and enable line. 
Apply a 1 KHz, 2 V P-P sine wave measured at ANASW TP1. 
Check that a 2 V P-P signal is in the Recorder window 

 
 
 

Q. External Power Supplies 
 

Halliburton External Power Supply and special notes 

 
Note the TELA board must have the high voltage 600V capacitors installed 

 Make sure nothing is connected to the line or EXT PS connectors then turn 
panel on. 

Make sure that the panel type in the control panel is CPFH. 

Go to utilities and edit logging service details. 

 Verify the service External Power Test exist “if not copy the none service as 
such” 

Verify that the following are present in the External Power Test service 

 Devices: Device3=SDSTIP,4 
 Controls: Over Current=2000 
   Over Voltage=600 
   External Power=YES 
Go to >>>Acquisition >>>Services >>> External Power Test 
Connect the External Power Supply to the EXT PS connector 
Connect the 300 ohm resistor to line out 
Go to >>>Acquisition >>> Action >>> Power Control >>>Enable 
Switch Polarity to Auto and leave the tool power switch OFF 
Turn on the external power supply. 
Push the OUTPUT button twice. 
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Connect a voltmeter to the line and slowly adjust the output to 400 V DC and 
1amp.  
Do not leave output at 400 V for more than 1 minute, adjust the output back to 
zero. 
Check that the front panel meters match the voltage and current applied. 
Power down the external power supply and disconnect the 300ohm load. 
 

R. RS232 and RS485 
 

Attach the RS232 loopback jumper to the two ports. 

Load the RS232  RS485 Loop Back service, vary the line speed and tine tension and check for the correct 
response from LtLoop, LsLoop, LtLoopBack and LsLoopBack. The LtLoop and LsLoop should be the 
same as line tension and line speed. The LtLoopBack LsLoopBack should be 10 times the respective value.   

Set the ports as following for the RS232 

SERMON   WWSA_STIP A 

 ASCTEL   WWSA_STIP A 

 SERMON2   WWSA_STIP C 

 ASCTEL2   WWSA_STIP C 

Set the ports as follows for the RS485  

 SERMON   WWSA_STIP B 

 ASCTEL   WWSA_STIP B 

 SERMON2   WWSA_STIP D 

 ASCTEL2   WWSA_STIP D 
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Appendix 
 Rack_mounting

  

Fig. 1 Panel layouts 


